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ABSTRAK 

 

Sebagai negara yang terletak pada daerah Ring Of Fire, Indonesia merupakan 

salah satu negara yang memiliki aktifitas seismik yang cukup tinggi dan rawan 

terhadap bahaya gempa, sehingga segala macam konstruksi di Indonesia harus lebih 

mengutamakan beban yang bekerja secara lateral yang berupa beban gempa, terutama 

bangunan sipil yang beresiko tinggi seperti bendungan urugan.  

Tujuan dari penelitian ini adalah untuk mengetahui potensi bahaya gempa 

(seismic hazard) serta stabilitas bendungan pada bendungan Way Apu yang terletak di 

Kec. Waepo, Kab. Buru, yang merupakan bagian dari Provinsi Maluku. Peneletian ini 

menggunakan metode PSHA (Pseudostatic Seismic Hazard Analysis) untuk 

mengetahui potensi bahaya gempa pada lokasi bendungan, serta analisis metode statik 

dan dinamik untuk mengetahui stabilitas bendungan yang ditinjau, dengan acuan SNI 

8064:2016 dan Pd-T 14-2004-A sebagai acuan. 

Hasil dari PSHA (Pseudostatic Seismic Hazard Analysis) menunjukkan bahwa 

Bendungan Way - Apu dikategorikan dalam klasifikasi kelas risiko IV (ekstrem) 

dengan nilai tingkat risiko sebesar 34 point, dan dari hasil analisis stabilitas bendungan 

menggunakan metode statis dan dinamis menunjukkan bahwa Bendungan Way-Apu 

memenuhi kriteria angka keamanan 
 

Kata Kunci: Ring of Fire, Bendungan Way-Apu, Stabiltas, PSHA, Bendungan Urugan. 
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ABSTRACT 

 

As a nation that’s situated in the Ring of Fire, Indonesia is a nation that have 

quite high seismic and vulcanic activites, and are vulnerable to earthquakes. 

Therefore the buildings that are being constructed must calculate the lateral load that 

is applied on the building, in this case, earthquake load, on most of the building that 

have a high risk when structural failure happens, like earthfill dams. 

The point of this study is to understand the seismic hazard and the dam stability 

of Way – Apu dam that’s located approximately in the Waepo sub-district, of the Buru 

District, from the Province of Maluku, using Pseudostatic Seismic Hazard Analysis 

(PSHA) for the seismic hazard, and Static and Dynamic analysis for the dam stability 

using, SNI 8064:2012 and Pd-T 14-2004-A as reference. 

From the results of Pseudostatcic Seismic Hazard Analysis (PSHA) showed that 

Way – Apu dam is categorized in IV in earthquake risk (extreme) with the risk point of 

34, and the results of static and dynamic analysis of the dam showed that Way – Apu 

dam fulfilled the criteria of the safety factor 
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1.0 BAB I   PENDAHULUAN 

PENDAHULUAN 

1.1 Latar Belakang  

Indonesia merupakan negara yang terletak di antara tiga lempeng tektonik 

utama, yaitu lempeng Eurasia, lempeng Indo-Australia, dan lempeng Pasifik. Interaksi 

antara ketiga lempeng tersebut dan kawasan Indonesia yang terletak pada daerah Ring 

of Fire menyebabkan Indonesia menjadi salah satu negara yang memiliki aktifitas 

seismik dan vulkanik paling tinggi di dunia dan rawan terhadap bahaya gempa, 

konstruksi bendungan di Indonesia tidak hanya perlu memperhatikan kestabilan 

terhadap keruntuhan akibat massa tanah saja, namun juga kestabilan bendungan 

terhadap beban gempa yang bekerja pada dalam berbagai kondisi muka air waduk. 

Tatanan lempeng tektonik utama Indonesia disajikan pada Gambar 1.1. 

 

Gambar  1.1  Tatanan Lempeng Tektoknik Utama di Indonesia 

(Pusgen, 2017) 

 

Gempa besar yang terjadi dapat menyebabkan kerusakan dan keruntuhan 

bangunan atau infrastruktur yang mengakibatkan kerugian besar baik dalam bentuk 

kerugian nyawa ataupun untuk proses rekonstruksi dan rehabilitasi. Penelitian ini 

bertujuan untuk mengkaji stabilitas bendungan urugan Way-Apu terhadap beban 
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gempa. Bendungan Way-Apu merupakan bendungan urugan zonal inti tegak yang 

terletak pada daerah Kecamatan Waepo, Kabupaten Buru, Provinsi Maluku yang 

memiliki fungsi utama sebagai pengendali aliran sungai Way-Apu agar tidak 

terjadinya banjir pada semua daerah irigasi, khususnya sebagian besar wilayah 

Kecamatan Waeapo maupun wilayah Kecamatan Waelata serta kecamatan lainnya 

pada umumnya. Letak geografis Bendungan Way-Apu dapat dilihat pada Gambar 1.2. 

 

 

Gambar  1.2  Lokasi Bendungan Way-Apu  
(Google Earth, 2022) 

 

Data rekam historis kegempaan yang mempengaruhi Pulau Buru, meliputi 

gempa pada bulan Juli tahun 2019 dengan magnitudo 7,2 dan pada bulan september 

tahun 2019 dengan magnitudo 6,2 yang menyebabkan kerusakan terhadap bangunan 

serta infrastruktur pada Kota Ambon, Kabupaten Buru, dan Kabupaten Halmahera 

selatan, oleh karena itu, evaluasi terhadap infrastruktur harus mempertimbangkan 

adanya resiko bahaya kegempaan yang tinggi. 

Metode yang akan digunakan untuk menganalisis bahaya kegempaan adalah 

Probabilistic Seismic Hazard Analysis (PSHA) dan metode stabilitas dinamik 

bendungan dengan menggunakan metode dinamik dengan time history. Penentuan 

metode tersebut ditentukan dalam peraturan perencanaan yang berlaku di Indonesia, 

yaitu SNI 8064:2016 dan Pd-T 14-2004-A untuk analisis bendungan urugan terhadap 

beban gempa. 
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1.2 Rumusan Masalah  

Berdasarkan latar belakang yang telah dipaparkan sebelumnya, rumusan 

masalah pada penelitian ini sebagai beriku ini. 

1. Bagaimana stabilitas statik lereng bendungan pada kondisi tanpa beban gempa,  

OBE (Operational Basis earthquake) dan MDE (Maximum Design 

Earthquake) baik pada bagian hulu dan hilir dengan beberapa variasi muka air 

waduk ? 

2. Bagaimana stabilitas dinamik lereng bendungan pada kondisi MDE (Maximum 

Design Earthquake) baik pada bagian hulu dan hilir dengan beberapa variasi 

muka air waduk ? 

1.3 Tujuan Penelitian 

Tujuan dari tugas akhir Analisis Stabilitas Tubuh Bendungan Way-Apu 

Terhadap Beban Gempa adalah sebagai berikut. 

1. Memperoleh stabilitas statik lereng bendungan pada kondisi  tanpa beban 

gempa,  OBE (Operational Basis earthquake) dan MDE (Maximum Design 

Earthquake) baik pada bagian hulu dan hilir dengan beberapa variasi muka air 

waduk 

2. Memperoleh stabilitas dinamik lereng bendungan pada kondisi MDE 

(Maximum Design Earthquake) baik pada bagian hulu dan hilir dengan 

beberapa variasi muka air waduk 

1.4 Manfaat Penelitian 

Harapan dengan dilaksanakannya penelitian ini adalah memberikan manfaat 

sebagai berikut. 

1. Manfaat Akademisi 

Untuk memperluas pengetahuan di bidang teknik sipil terutama dalam analisis 

stabilitas tubuh bendungan terhadap beban gempa, serta memberikan pemaham-

an mengenai pengaruh kegempaan terhadap bendungan. 

2. Manfaat Praktis 



4 

 

 
 

Sebagai pertimbangan dan rekomendasi bagi instansi pengelola Bendungan 

Way-Apu terhadap evaluasi keamanan Bendungan terhadap beban gempa 

terbaru tahun 2022. 

1.5 Batasan Masalah 

Adapun agar tugas akhir ini tidak meluas permasalahannya dan dapat terarah 

dengan baik sesuai tujuan awal penelitian, maka perlu ditetapkan batasan penelitian. 

Batasan-batasan dalam penelitian ini antara lain sebagai berikut. 

1. Bendungan tinjauan adalah bendungan Way-Apu yang berada pada wilayah 

administratif berada di wilayah Kecamatan Waepo, Kabupaten Buru, Provinsi 

Maluku. 

2. Bendungan Way-Apu merupakan bendungan urugan tipe zonal dengan inti tegak.  

3. Data parameter material bendungan yang digunakan adalah data sekunder, yang 

meliputi data material tubuh bendungan dan batuan dasar. 

4. Data rekam gempa yang digunakan diperoleh dari katalog gempa USGS dan ISC 

dari tahun 1900-2018 debgan radius 500 km dan kedalaman 300 km dari lokasi 

bendungan tinjauan. 

5. Standar yang digunakan dalam analisis adalah SNI 8064:2016, Pd-T 14-2004-A, 

Analisa Dinamik Bendungan Urugan (PU Balai Bendungan), serta peta gempa 

tahun 2017. 

6. Abakusus liquifaksi dan penurunan akibat gempa tidak dilakukan 

7. Kondisi air diasumsikan statik saat kondisi gempa. 
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2.0 BAB II   TINJAUAN PUSTAKA 

TINJAUAN PUSTAKA 

2.1 Penelitian Terdahulu   

Penelitian terdahulu digunakan sebagai referensi-referensi penelitian yang 

berkaitan dengan subyek dan objek penelitian. Penelitian penelitian terdahulu yang 

membahas tentang stabilitas bendungan yang dijadikan sebagai acuan untuk penelitian 

tugas akhir ini antara lain adalah sebagai berikut: 

2.1.1 Analisis Stabilitas Bendungan Urugan Tipe Urugan Zonal Inti Tegak dengan 

Perkuatan Timbunan terhadap Beban Gempa 

Ibrahim (2017) dalam penelitian tugas akhirnya yang berjudul “Analisis 

Stabilitas Bendungan Urugan Tipe Urugan Zonal Inti Tegak dengan Perkuatan 

Timbunan terhadap Beban Gempa” merupakan penelitian tentang stabilitas bendungan 

urugan tipe zonal inti tegak terhadap perkuatan timbunan trerhadap beban gempa 

dengan bendungan tinjauan berlokasi pada Jawa Barat.  

Dalam analisis yang dilakukan, peneliti menggunakan software GeoStudio 

untuk menganalisis stabilitas tubuh bendungan menggunakan metode analisis statik, 

pseudostatik, dan analisis dinamik yang dilakukan pada bagian hulu dan hilir 

bendungan dengan kondisi dengan dan tanpa perkuatan timbunan, dengan variasi 

muka air waduk meliputi waduk kosong (elevasi +180 m), intermediate (elevasi +260 

m), normal (elevasi +260 m), dan banjir (elevasi +262 m), dengan input beban gempa 

yang digunakan berupa beban gempa time history dengan kala ulang 100 tahun dan 

kala ulang 10.000 tahun (Ibrahim, 2017).  

Hasil yang diperoleh dari penelitian yang dilakukan oleh Ibrahim adalah angka 

safety factor, percepatan maksimum dengan kala ulang 500 tahun, 2500 tahun, dan 

10000 tahun, serta nilai displacement bendungan terhadap tiap kondisi muka air 

waduk (Ibrahim, 2017). 
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2.1.2 Analisis Stabilitas dan Respon Dinamik terhadap Displacement selama Gempa 

pada Bendungan Urugan Zonal Inti Tegak 

Aulawi (2018) pada penelitan tugas akhir yang berjudul “Analisis Stabilitas 

dan Respon Dinamik terhadap Displacement selama Gempa pada Bendungan Urugan 

Zonal Inti Tegak” merupakan penelitan tentang stabilitas bendungan urugan zonal inti 

tegak terhadap displacement selama gempa dengan objek penelitian tersebut adalah 

Bendungan Sutami, yang terletak pada Kecamatan Sumberpucung, Kabupaten 

Malang, Provinsi Jawa Timur.  

Dari hasil analisis yang dilakukannya, dengan bantuan software GeoStudio 

2018, untuk pemodelan analisis stabilitas bendungan, ArcGIS untuk pemodelan 

sumber area gejadian gempa, serta Microsoft Excel untuk membantu dalam 

pengolahan data gempa dan perhitungan input parameter material tubuh dan pondasi 

bendungan, dengan analisis stabilitas bendungan dilakukan menggunakan metode 

statik dan dinamik, dan analisis beban gempa menggunakan metode Probabilistic 

Seismic Hazard Analysis (PSHA) (Aulawi, 2018).  

Hasil penelitian yang dilakukan Aulawi (2018) ditemukan nilai safety factor 

pada bagian hulu dan hilir pada saat kondisi muka air waduk kosong yaitu, 2,156 dan 

1,802, pada kondisi muka air normal 2,147 dan 2,147, serta pada kondisi muka air 

banjir yaitu sebesar 2,088 dan 1,825.  

2.1.3 Analisis Stabilitas Statik dan Stabilitas Dinamik menggunakan Parameter 

Safety Evaluation Earthquake (SEE) pada Bendungan Urugan Zonal Inti Tegak 

Dewi (2018) pada penelitian tugas akhir yang berjudul “Analisis Stabilitas 

Statik dan Stabilitas Dinamik menggunakan Parameter Safety Evaluation Earthquake 

(SEE) Pada Bendungan Urugan Zonal Inti Tegak” merupakan penelitian tentang 

analisis stabilitas bendungan urugan zonal inti tegak, menggunakan metode statik dan 

dinamik dengan parameter Safety Evaluation Earthquake (SEE), dengan objek 

penelitian merupakan Bendungan Kedung Ombo, yang berlokasi di Desa Rambat, 

Kecamatan Geyer, Kabupaten Grobongan, Provinsi Jawa Tengah.  

Dalam analisis yang dilakukannya, dengan menggunakan metode Probabilistic 

Seismic Hazard Analysis (PSHA) untuk mencari beban gempa, serta metode statik, 

dan dinamik untuk mengetahui stabilitas bendungan, diketahui bahwa pada elevasi 
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muka air waduk kosong (elevasi +60 m), elevasi muka air waduk normal (elevasi +90 

m), dan elevasi muka air waduk saat bajir (elevasi +95 m) (Dewi, 2018). 

Hasil dari penelitian ini menunjukkan nilai safety factor pada bagian hulu dan 

hilir bendungan adalah masing masing, 1,895, dan 1,877; 1,690 dan 1,822; 1,619 dan 

1,886 dimana angka angka tersebut melebihi faktor kemanan minimum yaitu, 1,5 pada 

saat elevasi muka air waduk kosong, 1,3 pada saat elevasi muka air normal, dan 1,5 

pada saat elevasi muka air waduk saat banjir, dan percepatan gempa maksimum (peak 

ground acceleration) pada kala ulang 500 tahun adalah 0,11 g; kala ulang 2500 tahun 

adalah 0,302 g; serta pada kala ulang 10000 tahun adalah sebesar 0,44 g (Dewi, 2018). 

2.1.4 Analisis Stabilitas Bendungan menggunakan Metode Bishop dan Perhitungan 

Rembesan dengan Pendekatan Metode Cassagrande 

Sandi (2020) pada peneletian tugas akhir yang berjudul “Analisis Stabilitas 

Bendungan menggunakan Metode Bishop dan Perhitungan Rembesan dengan 

Pendekatan Metode Cassagrande” merupakan penelitian tentang stabilitas bendungan 

serta rembesan yang terjadi pada tubuh bendungan, dimana bendungan yang dijadikan 

tinjauan dalam penelitian tersebut adalah Bendungan Pondok, yang terletak di daerah 

Desa Dero, Kecamatan Beringin, Kabupaten Ngawi, Provinsi Jawa Timur.  

Sandi (2020) dalam analisis yang dilakukan pada penelitiannya, dia meng-

gunakan software GeoStudio untuk mengetahui gaya gaya yang bekerja pada tubuh 

bendungan, dimana hasil simulasi tersebut akan dibandingkan dengan perhitungan 

menggunakan metode bishop.  

Hasil yang didapatkan dari penelitian tersebut adalah nilai safety factor dari 

bendungan tanpa adanya beban gempa yaitu 2,479 pada kondisi elevasi muka air 

waduk kosong, 1,511 pada elevasi muka air waduk normal, dan 1,084 kondisi muka 

air banjir (Sandi, 2020). 

2.2 Keaslian Penelitian 

Tugas akhir ini dikerjakakan dengan tujuan untuk menganalisis stabilitas 

bendungan dengan menggunakan metode Probabilistic Seismic Hazard Analysis 

(PSHA) untuk mengetahui beban gempa, serta analisis statik dan dinamik untuk 

mengetahui stabilitas tubuh bendungan, serta dengan bantuan software GeoStudio. 
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Penelitian ini juga bertujuan untuk mengetahui nilai safety factor dari bendungan 

tinjauan terhadap beban gempa pada saat elevasi muka air waduk kosong, elevasi 

muka air waduk normal, dan elevasi muka air waduk saat banjir, yang dimana 

bendungan tinjauan tersebut adalah Bendungan Way-Apu yang berada di daerah 

Kecamata Waepo, Kabupaten Buru, Provinsi Maluku. Adapun terdapat Persamaan dan 

perbedaan antara tugas akhir ini dan penelitian-penelitan yang telah dilakukan 

sebelumnya. Hal tersebut tertera pada Tabel 2.1. 
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Tabel 2.1  Perbedaan Penelitian  

No Peneliti Judul Metode Tujuan Persamaan Perbedaan 

1 Pradana (2012) Analisis Struktur Bendungan Krenceng 

Terhadap Gempa 

Pseudostatik 

dan dinamik 

Nilai safety 

factor 

Tujuan Metode dan 

Objek 

Penelitian 

2 Ilham (2015)  Analisis Stabilitas Tubuh Bendungan pada 

Bendungan Utama Tugu Kabupaten 

Trenggalek 

Pseudostatik Nilai safety 

factor 

Tujuan Metode dan 

Objek 

Penelitian 

3 Ibrahim (2017) Analisis Stabilitas Bendungan Urugan Tipe 

Zonal Inti Tegak dengan Perkuatan Timbunan 

Terhadap Beban Gempa 

Statik. 

pseudostatik

, dan 

dinamik 

Nilai safety 

factor 

Tujuan Objek 

Penelitian 

4 Aulawi (2018) Analisis Stabilitas Statik dan Respon Dinamik 

Terhadap Displacement pada Bendungan 

Urugan Zonal Inti Tegak 

Statik, dan 

Dinamik 

Nilai safety 

factor 

Metode dan 

Tujuan 

Objek 

Penelitian 

5 Dewi (2018) Analisis Stabilitas Statik dan Stabilitas 

Dinamik Mengguanakan Parameter Safety 

Evaluation Earthquake (SEE) pada 

Bendungan Urugan Zonal Inti Tegak 

Statik, dan 

Dinamik 

Nilai safety 

factor 

Metode dan 

Tujuan 

Objek 

Penelitian 

6 Paransa (2023) Analisis Stabilitas Tubuh Bendungan Way-

Apu Terhadap Beban Gempa 

Statik dan 

Dinamik 

Nilai safety 

factor 
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3.0 BAB III   LANDASAN TEORI 

LANDASAN TEORI 

3.1 Bendungan Urugan 

Bendungan urugan adalah bendungan yang dibangun dari timbunan bahan-

bahan seperti batu, krakal, kerikil, pasir serta tanah ada komposisi tertentu 

berfungsi sebagai pengangkat permukaan air yang terdapat dalam waduk 

(Sosrodarsono, 1977). Secara garis besar tubuh bendungan dapat digolongkan 

menjadi tiga golongan, yaitu bendungan urugan homogen, bendungan urugan 

zonal, bendungan urugan bersekat.  

Bendungan tipe urugan zonal adalah bendungan yang memiliki gradasi 

butiran tanah penyusun yang berbeda masing-masing lapisan tertentu. Pada 

bendungan dengan tipe zonal, material penyangga bendungan dibebankan pada 

urugan yang mampu meloloskan air. Sedangkan material kedap air digunakan 

sebagai urugan yang menahan air. Berdasarkan pada letak dan kedudukan dari 

zona kedap airnya, bendungan tipe zonal dibagi menjadi tiga, yaitu sebagai 

berikut ini.  

1. Bendungan urugan zonal dengan tirai kedap air, dimana zona kedap air 

membentuk lereng udik bendungan tersebut. 

2. Bendungan urugan zonal dengan inti kedap air miring, dimana zona kedap 

airnya terletak didalam tubuh bendungan dan berkedudukan miring ke 

arah hilir 

3. Bendungan dengan urugan zonal dengan inti kedap air tegak, dimana zona 

kedap airnya terletak didalam tubuh bendungan dengan kedudukan 

vertikal. Biasanya inti dari tubuh bendungan terletak pada bagian tengah. 

Ilustrasi dari masing masing klasifikasi bendungan urugan dapat dilihat 

pada Gambar 3.1. 
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Gambar  3.1  Klasifikasi Umum Bendungan Urugan 
(Sumber: Sosrodarsono, 1977) 

 

Parameter bahan urugan diperkirakan berdasarkan dari data geologi lokal 

dan hasil uji laboratorium serta pengalaman. Bahan urugan dapat berupa batu, 

pasir kerikilan dan tanah lempungan yang dianjurkan berasal dari lokasi rencana 

bendungan. Pada dasarnya bahan dari konstruksi bendungan dapat dibedakan 

menjadi tiga jenis, yaitu sebagai berikut ini. 

1. Batuan. 

Batu digunakan sebagi pengisi lapisan lulus air atau semi lulus air pada 

bendungan zonal sekaligus sebagai lapisan pelindung (rip rap) pada lereng 

udik. 

2. Pasir dan kerikil 

Pasir dan kerikil digunakan sebagai bahan urugan bendungan sekaligus 

berfungsi sebagai lapisan filter dan lapisan transisi bendungan. 

3. Tanah lempung 

Tanah lempungan merupakan bahan utama bendungan urugan sebagai 

bahan dengan kekedapan yang tinggi. Tanah lempungan digunakan 
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sebagai bahan utama bendungan dengan tipe urugan tanah homogin 

maupun bendungan zonal. 

Sebagai acuan parameter material bendungan urugan digunakan standar 

SNI 8264:2016 yang didasarkan pada klasifikasi “Unified Soil Classification 

System” (USCS). Parameter tersebut dapat dilihat pada Tabel 3.1. 

Tabel 3.1  Parameter Bendungan Urugan 

Kelas 

USCS 
Tipe Tanah 

MDD 

(t/m3) 

OMC 

(%) 

ϕ’ 

(o) 

c’ 

(t/m2) 

GW 
Kerikil gradasi baik, 

campuran kerikil pasiran 
>1,91 <13,3 >38 - 

GP 
Kerikil gradasi buruk, 

campuran kerikil pasiran 
>1,76 <12,4 >37 - 

GM 
Kerikil lanau, kerikil pasiran 

lanauan gradasi buruk 
>1,83 <14,5 >34 - 

 

GC 

Kerikil lempungan kerikil 

pasiran lempungan gradasi 

buruk 

 

>1,84 

 

<14,7 

 

>31 

 

- 

SW 
Pasir gradasi baik, campuran 

pasir kerikilan 
1,91± 0,08 13,3±2,5 38±1 - 

SP 
Pasir gradasi buruk, 

campuran pasir kerikilan 
1,76±0,03 12,4±1,0 37±1 - 

SM 
Pasir lanauan, pasir lanau 

gradasi buruk 
1,83±0,02 14,5±0,4 34±1 2,01±0,67 

SM- 

SC 

Pasir lanuan lempungan 

plastisitas rendah 1,91±0,02 12,8±0,5 33±3 1,44±0,57 

 

SC 

Pasir lempungan campuran 

pasir lempungan gradasi 

buruk 
1,84±0,02 

 

14,7±0,4 

 

31±3 

 

1,15±0,57 

ML 
Lanau anorganik dan lanau 

lempungan 
1,65±0,02 19,2±0,7 32±2 0,86 

ML- 

CL 

Campuran lanau anorganik 

dan lempung 1,75±0,03 16,8±0,7 32±2 2,20 

 

CL 

Lempung anorganik dengan 

plastisitas rendah sampai 

medium 
1,73±0,02 

 

17,3±3,0 

 

28±2 

 

1,34±0,19 

 

OL 

Lanau organik dan lanau 

lempungan dengan 

plastisitas rendah 

 

- 

 

- 

 

- 

 

- 

MH 
Lanau lempungan 

anorganik, lanau elastis 
1,31±0,06 36,3±3,2 25±3 2,01±0,86 
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Kelas 

USCS 
Tipe Tanah 

MDD 

(t/m3) 

OMC 

(%) 

ϕ’ 

(o) 

c’ 

(t/m2) 

CH 
Lempung anorganik dengan 

plastisitas tinggi 
1,51±0,03 25,5±1,2 19±5 1,15±0,57 

OH 
Lempung dan lempung 

lanauan organik 
- - - - 

Pt 
  Tanah menganndung 

gambut dan organik 
- - - - 

(Sumber: SNI 8064:2016) 

 

Untuk mendapatkan parameter lain berupa specific grafity, angka pori (e), 

dan berat volume tanah, digunakan rumus persaman dan tabel korelasi yang 

disajikan yang pada Tabel 3.2. 

Tabel 3.2  Berat Jenis Tanah 

Jenis Tanah Specific Gravity 

Kerikil 2,65-2,68 

Pasir 2,65-2,68 

Lanau Anorganik 2,62-2,68 

Lempung Organik 2,58-2,62 

Lempung Anorganik 2,68-2,75 

Humus 1,37 

Gambut 1,25-1,8 

(sumber : Hardiyatmo, 2010) 

 

Untuk mendapatkan parameter tanah angka pori dan berat volume tanah 

digunakan Persamaan sebagai berikut: 

𝑒 =  
𝐺𝑠 ∙ 𝛾𝑤

𝛾𝑑
− 1    (3.1) 

 𝛾𝑏 =  
𝐺𝑠 ∙ 𝛾𝑤 ∙(1+𝑤)

1+𝑒
     (3.2) 

 𝛾𝑏 =  
𝛾𝑤 ∙ (𝐺𝑠+𝑒)

1+𝑒
    (3.3) 

Dengan : 
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e : Angka pori 

Gs : Specific gravity 

W : Kadar Air (%) 

γb : Berat volume basah (kN/m3) 

γb : Berat volume jenuh (kN/m3) 

 

Klasifikasi kelas batuan untuk konstruksi bendungan dan batuan dasar 

digunakan acuan Indonesia National Committee On Large Dam (INACOLD, 

2017). Parameter kelas batuan dapat dilihat pada Tabel 3.3. 

Tabel 3.3  Parameter Kelas Batuan 

 

Kelas 

Batuan 

Modulus 

elastisitas 

(kgf/cm2) 

Kuat Geser Kecepatan 

gelombang geser 

(m/sec) 
Kohesi 

(kgf/cm2) 

Sudut 

geser 

dalam 

( o ) 

CH 60000 20 45 2500 

CM 24000 10 35 1800 

CL 12000 8 30 1500 

D 6000 5 28 1200 
(Sumber: Inacold, 2017) 

3.2 Gempa Bumi 

Gempa bumi merupakan peristiwa pelepasan energi secara tiba-tiba yang 

mengakibatkan bergetarnya bumi. Gempa bumi biasanya ditandai dengan adanya 

patahan suatu lapisan batuan pada kerak bumi ditempat titik pusat gempa. Energi 

yang dilepaskan merupakan hasil dari pergerakan lempeng-lempeng tektonik yang 

dipancarkan kesegala arah berupa gelombang (Chopra, 1995). 

Teori yang terkenal dalam menjelaskan tentang terjadinya gempa bumi 

adalah teori lempeng tektonik. Teori tersebut menjelaskan bahwa lapisan terluar 

dari bumi terdiri dari litosfer dan antenosfer. Litosfer adalah lapisan padat dan 

kaku yang membentuk kerak dan bagian luar matel bagian atas yang berada di 

atas lapisan antenosfer. Lapisan antenosfer adalah lapisan yang berada dibawah 

litosfer yang bersifat plastis dan berwujud seperti cairan. Lempengan-lempengan 

litosfer akan bergerak satu sama lain yang mengakibatkan deformasi pada zona 
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batas pertemuan antar lempeng. Deformasi terjadi pada zona batas antara 

lempeng, maka titik gempa akan terpusat di dekat batas lempeng (Kramer, 1996). 

Pergerakan lempeng terbagi menjadi tiga jenis pergerakan berdasarkan 

pada karakteristik dari lempeng yaitu pergerakan lempeng yang saling menjauh 

(Spreading), pergerakan lempeng yang saling mendekat membentuk zona 

subduksi, dan saling bergesekan (transform). 

Pergerakan lempeng saling menjauh (spreading) terjadi ketika magma dari 

bagian bawah mantel bergerak perlahan ke permukaan akibat dari aktivitas 

seismik, saat magma tersebut mencapai permukaan dan dingin akan menjadi 

bagian dari spreading. Peristiwa ini biasanya terjadi apabila terdapat gugusan 

aktivitas vulkanis seperti yang terjadi di Islandia dimana terdapat gugusan 

aktivitas vulkanis yang continous. Lapisan magma yang mendingin tersebut 

mencapai permukaan akan mengandung sifat magnet dengan polaritas tergantung 

pada arah medan magnet dari bumi pada saat itu. Hal ini dikarenakan medan 

magnet bumi secara geologis berubah dan berbalik arah dengan interval waktu 

yang tidak menentu. Peristiwa spreading di ilustrasikan pada Gambar 3.2.  

 

 

Gambar  3.2  Ilustrasi Peristiwa Spreading  
(Sumber: Kramer, 1996) 

  

Zona subduksi sering ditemukan pada pertemuan antara dua lempeng 
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besar. Karena lempeng samudra biasanya padat mengakibatkan lempeng 

mengalami penurunan karena berat sendiri dibawah lempeng besar lain yang lebih 

ringan. Lempeng yang mengalami subduksi menjadi ductile dan sangat berpotensi 

mengakibatkan gempa bumi (Kramer,1996).  

Lempeng yang saling bergesekan terjadi saat lempeng bergerak cepat satu 

sama lain tanpa memunculkan lempeng baru atau merusak lempeng yang sudah 

ada. Bagian lempeng dimana terjadi gesekan biasanya terdapat anomali medan 

magnet yang menimbulkan celah yang disebut fracture zone dengan panjang 

mencapai ribuan kilometer. Kedua lempeng yang bergesekan bergerak searah 

pada kedua sisi dari fracture zone dengan pergerakan yang bermacam-macam. 

Pergerakan lempeng di ilustrasikan pada Gambar 3.3. 

 

Gambar  3.3  Ilustrasi Gesekan Antara Dua Lempeng (a) Oblique (b) Tampak 
(Sumber: Kramer, 1996) 

 

Patahan (fault) dapat mengakibatkan gempa bumi. Patahan dapat dibeda-

kan menjadi dua jenis berdasarkan geometri dan pergerakannya. Penggambaran 

orientasi sebuah patahan digunakan istilah tunjaman (dip) dan tabrakan (strike). 

Tabrakan merupakan garis horizontal yang terbentuk akibat dari interseksi dari 

bidang patahan dan bidang horizontal. Garis vertikal kebawah akibat interseksi 

antara bidang patahan dengan bidang horizontal disebut tunjaman. Sudut yang 

terbentuk antara bidang patahan dengan bidang horizontal yang diukur tegak lurus 

dari tabrakan disebut dip angle. Notasi geometris untuk menggambarkan 

interseksi bidang patahan di ilustrasikan pada Gambar 3.4.  
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Gambar  3.4  Notasi Geometris untuk Menggambarkan Interseksi Bidang Patahan  
(Sumber: Kramer, 1996) 

 

Pergerakan dip yang terjadi dapat dibedakan menjadi 2 jenis berdasarkan 

arah pergerakan dan dip angle, yaitu: 

1. Normal Fault, terjadi jika komponen horizontal dari kemiringan 

diperpanjang dan material diatas bidang patahan yang bergerak turun 

relatif terhadap material dibawah patahan. 

2. Reverse Fault, terjadi bila komponen horizontal dari kemiringan 

diperpendek dan material di atas bidang patahan bergerak naik relatif 

terhadap material dibawah bidang patahan. 

Ilustrasi dari jenis patahan normal fault, reverse fault, dan strike slip dapat 

dilihat pada ilustrasi Gambar 3.5. 

 

Gambar  3.5  Ilustrasi Jenis Patahan (a) Normal Fault, (b) Strike Slip, (c) Reverse Fault 
(Sumber: Kramer, 1996) 
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Gambar  3.6  Ilustrasi Perambatan Gelombang Gempa 
(Sumber: Kramer, 1996) 

 

Gempa bumi yang terjadi akan mengakibatkan pelepasan energi, energi 

yang dilepaskan akan merambat dalam bentuk gelombang. Gelombang rambatan 

yang terjadi menyebabkan getaran pada suatu tempat. Berikut ilustrasi proses 

perambatan gelombang gempa bumi dapat dilihat pada Gambar 3.6. 

3.3 Magnitudo Gempa 

Magnitudo gempa merupakan ukuran secara kuantitatif dan objektif 

terhadap gempa untuk mengukur gerakan tanah selama gempa bumi. Besaran 

yang diukur akan bernilai sama walaupun pengukuran atau penghitungan 

dilakukan pada tempat yang berbeda. Pada umumnya magnitudo diukur 

berdasarkan periode fase gelombang dan amplitudo tertentu. Ada beberapa jenis 

magnitudo gempa bumi antara lain: 

3.3.1 Magnitudo Lokal (ML) 

Magnitudo lokal digunakan untuk mengukur gempa-gempa lokal dengan 

jarak episenter kurang dari 600 km yang menggunakan fase gelombang-P. konsep 

tentang magnitudo local pertama diperkenalkan oleh Charles Richter (1935) untuk 

mengukur magnitudo gempa di California selatan. Nilai amplitudo yang 

digunakan untuk menghitung magnitudo lokal adalah logaritma (basis 10) dari 

amplitudo maksimum gerakan tanah (dalam mikron). Amplitudo maksimum 



19 

 

 
 

dicatat oleh seismograph torsi Wood-Anderson yang mempunyai periode natural 

0,8 detik dengan perbesaran 2800 dan faktor redaman 0,8. Formula untuk 

menghitung magnitudo lokal tidak dapat digunakan di luar California dan data 

amplitudo yang dipakai hanya yang tercatat pada mesin seismograph di lokasi 

tinjauan. 

3.3.2 Magnitudo Gelombang Permukaan (MS) 

Magnitudo gelombang permukaan merupakan satuan magnitudo yang 

dapat digunakan di seluruh dunia menggunakan basis amplitudo dari gelombang 

Rayleigh dengan periode 20 detik. Konsep magnitudo gelombang permukaan 

diperkenalkan oleh Guttenberg dan Richter (1936). Magnitudo gelombang 

permukaan mengunakan basis besaran perpindahan maksimum amplitudo dari 

tanah sehingga dapat ditentukan dari semua jenis seismograph. Satuan magnitudo 

gelombang permukaan hanya dapat digunakan untuk gempa dengan kedalaman 

dangkal (tidak lebih dari 70 km). 

3.3.3 Magnitudo Gelombang Badan (Mb) 

Magnitudo gelombang badan merupakan magnitudo gempa yang 

diperoleh dari amplitudo gelombang badan yang primer maupun sekunder yang 

tidak terpengaruh kedalaman fokus gempa. Amplitudo yang dipakai adalah 

amplitudo gerakan tanah maksimum (dalam mikron) yang diukur pada 3 

gelombang yang pertama dari gelombang-P dan periode gelombang yang 

mempunyai amplitudo maksimum tersebut (Yulianti, 2012). 

3.3.4 Momen Magnitudo (MW) 

Gempa besar mempunyai karakteristik guncangan tanah kurang sensitif 

terhadap besarnya gempa dibandingkan gempa yang lebih kecil. Fenomena ini 

dikenal sebagai kejenuhan gelombang badan dan Richter local magnitudo menjadi 

jenuh pada magnitudo 6 sampai 7 dan magnitudo permukaan menjadi jenuh pada 

Ms = 8. Skala momen magnitudo yang dikembangkan Kanamori (1977) 

digunakan untuk mendeskripsikan ukuran gempa yang besar, karena skala momen 



20 

 

 
 

magnitudo didasarkan pada momen gempa. Sehingga tidak tergantung pada 

tingkat guncangan tanah dan kejenuhan gelombang. Skala momen magnitudo 

diperoleh dengan melakukan pengukuran langsung dari faktor keruntuhan 

sepanjang patahan. 

Untuk melakukan analisis resiko kegempaan menggunakan skala 

magnitudo yang seragam untuk semua data rekam gempa. Untuk menyeragamkan 

skala magnitudo dari semua data rekam gempa digunakan Persamaan korelasi 

yang diusulkan oleh Asrurifak et al (2010) untuk data rekam gempa di wilayah 

Indonesia. Persamaan dapat dilihat pada Tabel 3.4. 

Tabel 3.4  Korelasi Konversi Skala Magnitudo di Indonesia 

Korelasi konversi Range Data Kesesuaian (R2) 

Mw = 0,143 Ms2 -1,051Ms + 7,285 4,5 ≤ Ms ≤ 8,6 93,9 % 

Mw = 0,114 Mb2 - 0,556 Mb + 5,560 4,9 ≤ Mb ≤ 8,2 72,0 % 

Mw = 0,787 ME + 1,537 5,2 ≤ ME ≤ 7,3 71,2 % 

Mb = 0,125 ML – 0,389 ML + 7,285 4,5 ≤ ML ≤ 8,6 56,1 % 

ML = 0,717 MD + 1,003 4,5 ≤ MD ≤ 8,6 29,1 % 

(sumber : Asrurifak et al, 2010) 

3.4 Analisis Bahaya Gempa/ Seismic Hazard Analysis 

Metode dalam analisis bahaya gempa atau seismic hazard analysis 

terdapat dua metode yang dapat digunakan yaitu Deterministic Seismic Hazard 

Analysis dan Probabilistic Seismic Hazard Analysis. Dalam melakukan analisis 

digunakan metode Probabilistic Seismic Hazard Analysis (PSHA) dipilih karena 

dapat memperkirakan kemungkinan besar probabilitas gempa itu akan terjadi. 

Kelebihan dari metode PSHA tidak dapat diakomodasi oleh DSHA, walaupun 

dalam memperkirakan scenario terburuk kejadian gempa di suatu wilayah lebih 

sederhana dibandingkan dengan PSHA. Probabilistic Seismic Hazard Analysis 

(PSHA) menyediakan kerangka kerja yang dapat mengidentifikasi ketidakpastian 

tentang ukuran, lokasi dan tingkat kejadian dari gempa bumi.  

Pada dasarnya, metode PSHA adalah analisis yang dikembangkan oleh 
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Mc. Guire (1976) berdasarkan konsep probabilitas dari Cornell (1968). Metode ini 

menggunakan variasi scenario yang melibatkan frekuensi ground motion, dengan 

mengasumsikan kejadian gempa magnitudo M dan jarak hiposenter R adalah 

variabel acak independen yang kontinyu. Variasi skenario juga melibatkan sifat 

acak gempa bumi seperti lokasi pusat gempa, besarnya gempa, dan tingkat 

kejadian gempa.  

Perhitungan PGA dengan metode PSHA dapat dapat dinyatakan dalam 

Persamaan (3.4) sebagai berikut (Kramer, 1996): 

 

𝜆(𝛼 > 𝛼 ∗) = ∑𝑛𝑠
𝑖=1 𝜈(𝑀𝑖 > 𝑚0) ∑𝑛𝑟

𝑘=1 𝑃[𝑚𝑗𝑟𝑘]𝑃[𝑀𝑖 = 𝑚𝑗] 𝑃[𝑟𝑖 = 𝑟𝑘  (3.4) 

 

dengan :  

 𝜆(𝑎 > 𝑎 ∗ )   : rate of exceeding PGA terlampaui  

 ν    : annual exceedence rate  

 𝑃 [𝑀𝑖 = 𝑚𝑗 ]   : fungsi distribusi magnitudo  

 𝑃 [𝑅𝑖 = 𝑟𝑘 ]   : fungsi distribusi jarak  

 𝑃[ 𝑎 > 𝑎 ∗ |𝑚𝑗𝑟𝑘]  : probabilitas bersyarat dari nilai percepatan tanah  

      maksimum PGA yang melampaui nilai PGA pada  

      lokasi yang ditinjau untuk kejadian gempa dengan  

      magnitudo m dan jarak r. 

Fungsi ditribusi dari variabel magnitudo dan jarak dapat ditentukan 

dengan membagi masing-masing variabel menjadi 10 kelas interval 

(Kramer,1996). Perhitungan distribusi magnitudo dilakukan dengan menggunakan 

Persamaan (3.5) sebagai berikut: 

𝑃 [𝑀𝑖 = 𝑚𝑗] =  
∑ 𝑁 𝑚

𝑗
𝑖  (𝑗) 

∑ 𝑁𝑚
𝑗
𝑖

     (3.5) 

 

Dengan;  

Σ N m(j) : Jumlah kejadian gempa dengan magnitudo j  

Σ N m  : Jumlah kejadian gempa total 
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Perhitungan fungsi distribusi jarak dilakukan dengan menggunakan Persamaan 

(3.6) sebagai berikut: 

 𝑃 [𝑅𝑖 = 𝑟𝑘] =  
∑ 𝑁𝑟𝑘

𝑖  (𝑘) 

∑ 𝑁𝑟𝑘
𝑖

     (3.6) 

 

Perhitungan Probabilitas PGA melampaui angka tertentu dilakukan dengan 

menggunakan Persamaan (3.7) dan (3.8) sebagai berikut: 

 

𝑧 =  
𝑙𝑛𝑙𝑛 𝑎−𝑙𝑛𝑙𝑛 𝑃𝐺𝐴  

𝜎
      (3.7) 

 𝑃(𝑀 = 𝑚, 𝑅 = 𝑟) =  𝑓𝑧(𝑍∗) =  
1

2√𝜋𝜎𝑙𝑛𝑙𝑛 𝑃𝐺𝐴  
𝑒𝑥𝑝 𝑒𝑥𝑝 (

−𝑧2

2𝜎2)  (3.8) 

 

Dengan: 

𝑓z (𝑧*) : fungsi kerapatan probabilitas 

ln 𝑎  : percepatan tanah maksimum yang ditinjau 

σ  : standar deviasi dari ln PGA 

 

Metode PSHA dapat dideskripsikan dalam empat langkah prosedur 

sebagai berikut: 

1. Langkah pertama merupakan identifikasi dan karakterisasi sumber gempa, 

yang identik dengan langkah pertama DSHA. Probabilitas dari lokasi 

rupture yang berpotensi dalam sumber gempa juga di karakterisasi. Dalam 

kebanyakan kasus, diterapkan distribusi probabilitas seragam untuk 

masing-masing zona sumber gempa. Disribusi ini dikombinasikan dengan 

bentuk geometri dari sumber gempa untuk mendapatkan distribusi 

probabilitas yang sesuai dengan jarak sumber ke lokasi. 

2. Langkah selanjutnya, seismisitas atau distribusi sementara dari perulangan 

kejadian gempa di karakterisasi. Hubungan perulangan kejadian gempa 

yang menunjukan kecepatan rata-rata dari suatu gempa dengan besar yang 

berbeda akan terlampaui digunakan untuk mengkarakterisasikan 

seismisitas dari masing - masing zona sumber gempa. Hubungan empiris 

ini dapat mengakomodasi besarnya magnitudo maksimum dari gempa. 
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Tetapi tidak dilakukan pembatasan pertimbangan untuk gempa yang 

terjadi. 

3. Gerakan tanah yang terjadi akibat adanya gempa besaran tertentu dan 

lokasi tertentu harus ditentukan menggunakan hubungan prediksi 

menggunakan fungsi atenuasi. Ketidakpastian dari fungsi atenuasi juga 

diperhitungkan. 

4. Ketidakpastian dari lokasi gempa, besarnya gempa dan prediksi parameter 

goncangan tanah (percepatan gempa), dikombinasikan untuk mendapatkan 

probabilitas terlampauinya suatu parameter goncangan tanh selama suatu 

periode waktu. 

 

Ilustrasi yang dapat menjelaskan seluruh langkah tersebut dapat dilihat 

tahapan seperti pada Gambar 3.7. 

 

Gambar  3.7  Tahapan Analisis Bahaya Gempa dengan Metode PSHA 
(Sumber: Kramer, 1996) 

 

Dalam melakukan perhitungan kemungkinan periode ulang gempa ada 

suatu periode digunakan persaman (3.9) sebagai berikut: 

 𝑃 [𝑁 > 1] = 1 − 𝑒−𝑅𝑎∙𝑇      (3.9) 

Dengan : 

Ra  : Angka kejadian terlampaui (g) 

T  : Periode kala ulang (tahun) 
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3.5 Katalog Gempa 

Katalog gempa adalah salah satu elemen penting dalam analisis resiko 

kegempaan. Katalog data gempa merupakan sumber utama dalam menentukan 

parameter seismik yang akan menjadi input dalam proses analisis resiko gempa. 

Data yang didapat dari katalg gempa harus dipersiapkan sebelu dapat dianalisis. 

Adapun tahapan persiapan data gempa itu akan dibahas pada bagian berikut ini.  

3.5.1 Penyeragaman Magnitudo Gempa 

Data rekam gempa yang diperoleh dalam tahap pengumpulan data dari 

katalog gempa. Data yang diperoleh diseragamkan skala magnitudo untuk dibuat 

katalog gempa yang akan di analisis. Data awal rekam gempa tersebut memiliki 

berbagai macam skala magnitudo seperti moment magnitude (MW), surface wave 

magnitude (MS), body wave magnitude (Mb) dan Richter local magnitude (ML). 

Penyeragaman skala magnitudo dilakukan konversi ke skala moment magnitude 

(MW) menggunakan Persamaan korelasi konversi skala magnitudo yang 

diusulkan Asrurifak et al. (2010) pada Tabel 3.3. 

3.5.2 Declustering Data Gempa 

Katalog data gempa yang digunakan dalam proses analisis seismik resiko 

gempa harus merupakan data rekam gempa independen (mainshock). De-

clustering merupakan proses identifikasi dan pemisahan data gempa dependen 

yaitu gempa rintisan (foreshock) dan susulan (aftershock) terhadap gempa utama 

(mainshock). Kriteria empiris untuk memisahkan gempa dependen tersebut 

diusulkan oleh Arabasz & Robinson (1976), Gardner & Knopoff (1974) dan 

Uhammer (1986). Kriteria ini dikembangkan berdasarkan rentang waktu dan jarak 

tertentu dari satu kejadian gempa besar. Gambar 3.8. berikut adalah kriteria 

window dalam proses declustering data gempa.  
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Gambar  3.8  Kriteria Time dan Distance Windows untuk Declustering 
(Sumber: Irsyam dkk., 2007) 

 

Kriteria ini dikembangkan berdasarkan rentang waktu dan jarak tertentu 

dari satu kejadian gempa besar. Suatu rangkaian gempa dikatakan gempa 

dependen jika gempa tersebut berada dalam rentang waktu (time windows) dan 

jarak (distance windows) yang dihitung menurut kriteria empiris dari magnitudo 

gempa utama. 

3.5.3 Analisis Kelengkapan Data Gempa 

Asrurifak et. al (2010) menyatakan ketidaklengkapan data gempa akan 

meng-akibatkan parameter resiko gempa yang dihasikan menjadi overestimated 

atau underestimated. Stepp (1973) mengusulkan suatu kriteria untuk menguji 

kelengkapan data rekam gempa. Untuk mengetahui periode dimana suatu katalog 

gempa yang digunakan cukup lengkap, frekuensi kejadian gempa independen 

untuk beberapa rentang magnitudo diplotkan terhadap waktu yang dihitung dari 

waktu pengamatan terakhir kebelakang. Frekuensi kejadian gempa (λ) 

didefinisikan sebagai jumlah kejadian gempa (N) selama selang waktu tertentu (T) 

dibagi dengan T, dengan asumsi bahwa seismic rate konstan untuk rentang 

periode yang lama sewaktu dimana frekuensi kejadian gempa mulai menurun 

secara signifikan menyatakan suatu batas waktu dimana katalog gempa 

sebelumnya tidak lengkap. Langkah untuk menganalisa kelengkapan data gempa 
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yang diusulkan oleh Stepp (1973) adalah sebagai berikut: 

1. Waktu pengamatan beberapa interval waktu dihitung dari pengamatan 

terakhir ke belakang. 

2. Setiap interval waktu dari data gempa dibagi menjadi beberapa rentang 

magnitudo dan dihitung untuk kejadian gempa pada setiap rentang 

magnitudo. 

3. Frekuensi kejadian gempa (rate) untuk setiap rentang magnitudo dihitung 

dengan Persamaan (3.10). 

 

 𝜆 =  
∑ 𝑁

𝑇
     (3.10) 

 

Dengan:  

λ  : frekuensi kejadian gempa (rate) 

N  : jumlah kejadian gempa  

T  : interval waktu pengamat 

 

4. Standar deviasi dihitung menggunakan Persamaan (3.11) sebagai berikut: 

 

 𝜎 =  
√𝜆

√𝑇
     (3.11) 

Dengan:  

σ : standar deviasi 

λ  : frekuensi kejadian gempa (rate) 

T  : interval waktu pengamat 

 

Kelengkapan data pada periode waktu tertentu dapat dilihat dari gradien 

kecenderungan data yang berubah. Rentang waktu dimana standar deviasi 

menunjukkan perubahan dan menjadi lebih curam menunjukkan data gempa yang 

tidak lengkap. Contoh hasil analisis kelengkapan data gempa interval waktu 100 

tahun untuk Jatigede seperti ditampilkan pada Gambar 3.9. 



27 

 

 
 

 

Gambar  3.9 Hasil Analisis Kelengkapan Data Gempa Interval 100 Tahun Jatigede 
(Sumber: Ibrahim, 2017) 

 

3.6 Earthquake Recurrence Parameter 

Data rekam kegempaan suatu daerah diperoleh dari rekaman di masa lalu 

dapat digunakan untuk mengetahui resiko tercapainya atau terlampauinya suatu 

intensitas gerakan tanah setempat di masa yang akan datang. Perhitungan resiko 

gempa dilakukan dengan dasar informasi kegempaan dari suatu daerah, 

diantaranya: 

1. Pencatatan gempa yang pernah ada pada lokasi tinjauan 

2. Sejarah kejadian gempa pada daerah yang dalam radius lokasi tinjauan 

3. Data geologi berupa zona potensi sumber gempa daerag yang ditinjau 

 

Probabilistic Seismic Hazard Analysis (PSHA) memerlukan suatu model 

perulangan gempa dengan magnitudo yang bervariasi. Model kemunculan gempa 

(Earthquake Recurrence Model) yang diberikan oleh beberapa peneliti digunakan 

untuk memperkirakan besarnya resiko kemunculan suatu kejadian gempa pada 

suatu periode perulangan tertentu. Earthquake Recurrence Model yang sering 

digunakan dalam analisis PSHA merupakan Least Square Method (Gutenberg & 

Richter, 1954), yaitu pemodelan hubungan magnitudo versus frekuensi seperti 
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yang disajikan dalam Gambar 3.10. 

 

Gambar  3.10 Earthquake Recurrence Model 
(Sumber: Guttenberg & Ritcher, 1954) 

 Menurut Gutenberg-Richter (1954), frekuensi terjadinya gempa dengan 

magnitudo M ≥ m persatuan waktu, menurun secara ekponensial dengan 

meningkatnya magnitudo gempa, dan dapat dinyatakan dengan Persamaan 

berikut: 

 𝐿𝑜𝑔 𝑁 = 𝑎 − 𝑏 𝑀      (3.12) 

Dengan: 

N : frekuensi terjadinya gempa dengan magnitudo M lebih besar atau sama 

dengan m per satuan waktu (ditentukan dengan memakai metode 

penyesuaian kuadrat terkecil terhadap data pengamatan yang tersebar). 

M  : Magnitudo gempa. 

a  : konstanta karakteristik daerah gempa yang tergantung waktu pengamatan 

(To) dan tingkat kegempaan daerah sumbernya. 

b  : konstanta karaktersitik daerah gempa yang merupakan kemiringan garis 

pada grafik Log N versus m, menyatakan penyebaran relatif dari 

magnitudo gempa pada sembarang sumber titik pada daerah sumber 

gempa. Nilai b yang lebih besar menunjukkan terjadinya gempa dengan 

magnitudo besar yang lebih langka. 



29 

 

 
 

 

3.7 Permodelan Sumber Gempa 

3.7.1 Area Source 

Pemodelan sumber gempa didasarkan pada interpretasi data gempa 

kedalam area yang berisi data gempa yang telah dikelompokan (Aguilar, 2017). 

Pengelompokan data gempa akan menghasilkan tingkat seismisitas dan data 

geometri dari tiap area. Gabungan dari data seimisitas dan geometri akan 

menghasilkan area source yang akan menjadi input dalam analisis PSHA 

menggunakan R-CRISIS 20.0. 

Pengelompokan data gempa dibagi berdasarkan kedalaman ke dalam 

interval kedalaman. Pemisahan data gempa kedalam tiga interval bertujuan untuk 

mengelompokan data gempa berdasarkan sumbernya mencakup gempa Shallow 

crustal yang meliputi subduksi dan patahan. Interval yang lebih dalam bertujuan 

mengelompokan gempa kedalam deep background. Tiap interval kedalaman data 

gempa akan diambil nilai tengahnya untuk dijadikan satu kedalaman pada tiap 

interval kedalaman. 

Data gempa pada tiap kedalaman akan dikelompokan untuk dijadikan area 

source berdasarkan gempa yang saling berdekatan. Area source akan dibentuk 

menjadi beberapa polygon sebagai input geometri untuk analisis kegempaan. 

Gempa yang memiliki jarak yang berjauhan dan atau tidak bisa dikelompokan 

akan dijadikan satu area source untuk gempa background. Kedalaman gempa 

subduksi mengikuti geometri dari subduksi dengan kedalaman bagian atas 

subduksi 5 km dan bagian bawah 50 km. Geometri dari area subduksi diambil dari 

Peta Sumber dan Bahaya Gempa Indonesia Tahun 2017. Gempa yang masuk ke 

dalam area subduksi dianggap sebagai gempa yang bersumber dari subduksi. 

Ilutrasi pengelompokan ditunjukan pada Gambar 3.11. 
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Gambar  3.11 Ilustrasi Pengelompokan Data Rekam Gempa 
(Sumber: Pengolahan Data, 2022) 

 

3.7.2 Geometry Source 

Geometry source merupakan polygon yang terbentuk akibat peng-

kelompokan data gempa. Polygon yang terbentuk berbentuk beraturan atau tidak 

beraturan tergantung pada persebaran data gempa yang dikelompokan. Persebaran 

data gempa mempengaruhi luasan polygon yang terbentuk. Jarak antar titik gempa 

yang saling berjauhan akan menghasilkan polygon yang memiliki luasan yang 

besar, sementara jika jarak antar titik gempa semakin berdekatan maka akan 

menghasilkan polygon yang memiliki luasan lebih kecil. 

3.7.3 Seismicity Source 

Seismicity source merupakan sifat seismik dari geometry source berupa 

nilai lamda, beta, dan magnitudo. Nilai seismik dari suatu geometri berkaitan 

dengan jumlah dari data gempa yang dicakup dalam sebuah polygon. Perhitungan 

masing-masing parameter seismik dalam input seismisitas dapat menggunakan 

Persamaan (3.13) hingga Persamaan (3.17) sebagai berikut. 

𝑟𝑎𝑡𝑒 =  
𝑗𝑢𝑚𝑙𝑎ℎ 𝑑𝑎𝑡𝑎 𝑔𝑒𝑚𝑝𝑎

𝑤𝑎𝑘𝑡𝑢 𝑖𝑛𝑡𝑒𝑟𝑣𝑎𝑙 𝑔𝑒𝑚𝑝𝑎
     (3.13) 

 𝑎 =  
∑ 𝑥+ ∑ 𝑦

∑ 𝑧
    (3.14) 
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𝑏 =  
∑ 𝑧∙∑ 𝑥𝑦−∑ 𝑥 ∙∑ 𝑦

∑ 𝑧∙∑ 𝑥2−(∑ 𝑥)2
   (3.15) 

 

 

Dengan: 

Z : Jumlah interval magnitudo 

x  : median interval magnitudo  

y  : log-rate kumulatif 

 

𝛽 = 𝑏 ∙𝑙𝑛 𝑙𝑛 10       (3.16) 

 𝜆 = 10(𝑎−𝑏∙𝑚𝑒𝑎𝑛)     (3.17) 

3.8 Hazard Maps 

Hazard maps merupakan input peta dengan format shapefile (.shp) dalam 

analisis kegempaan menggunakan software R-CRISIS 20.0. Analisis kegempaan 

yang dilakukan mencakup satu wilayah, hal ini dikarenakan R-CRISIS 20.0 tidak 

dapat menganalisis kegempaan pada satu titik tinjauan. Peta wilayah yang 

digunakan adalah peta wilayah daerah administratif dalam lingkup kabupaten. 

Peta yang menjadi input dalam analisis adalah peta Kabupaten Buru. Contoh hasil 

analisis kegempaan berupa hazard maps ditunjukan pada Gambar 3.12. 

 

Gambar  3.12 Ilustrasi Hasil Hazard Maps 
(Sumber: Pengolahan Data, 2022) 
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3.9 Exceedance Probability 

Exceedance Probability untuk hazard maps adalah tetapan exceedance 

probability untuk keseluruhan peta hazard yang akan memunculkan hasil 

intensitas yang berkaitan dengan exceedance probability yang menjadi masukan. 

Perhitungan exceedance probability untuk masing-masing kala ulang kejadian 

gempa menggunakan Persamaan (3.18) sebagai berikut. 

𝐸𝑥𝑐𝑒𝑒𝑑𝑒𝑛𝑐𝑒 𝑝𝑟𝑜𝑏𝑎𝑏𝑖𝑙𝑖𝑡𝑦 = 1 − 𝑒𝑥𝑝 (
𝑡𝑖𝑚𝑒 𝑓𝑟𝑎𝑚𝑒

𝑘𝑎𝑙𝑎 𝑢𝑙𝑎𝑛𝑔 𝑘𝑒𝑗𝑎𝑑𝑖𝑎𝑛
)   (3.18) 

Dengan: 

Time frame  : tetapan time frame yang digunakan 

Kala ulang kejadian : kala ulang kejadian yang dianalisis 

3.10 Fungsi Atenuasi dan Logic Tree 

Fungsi atenuasi merupakan fungsi yang menggambarkan hubungan antara 

magnitudo (M), intensitas (i) gerakan tanah setempat, dan jarak (R) dari sumber 

daerah pusat gempa. Perkiraan fungsi atenuasi untuk gerakan tanah akibat gempa, 

telah menjadi subjek yang menarik dalam penelitian bidang kegempaan. Fungsi 

atenuasi merupakan alat yang penting dalam mengaplikasikan resiko kegempaan 

dalam perencanaan bangunan tahan gempa. Penggunaan fungsi atenuasi untuk 

perhitungan PGA memiliki faktor yang mempengaruhi fungsi atenuasi yang 

digunakan, antara lain mekanisme gempa, jarak episenter dan kondisi tanah lokal.  

Logic tree adalah suatu kerangka kerja untuk mengatasi nilai ketidak-

pastian parameter yang dipakai pada saat perhitungan analisa resiko gempa 

dengan menggunakan metode PSHA. Nilai ketidakpastian parameter didapat dari 

Persamaan atenuasi, parameter resiko gempa dan magnitudo maksimum. 

Pendekatan logic tree memungkinkan penggunaan beberapa alternatif metode atau 

model dalam analisis, dimana tiap model yang digunakan untuk suatu parameter 

akan dikalikan dengan suatu faktor bobot yang merepresentasikan keakuratan 

relatif suatu model terhadap model lainnya (Irsyam et.al, 2010). Jumlah faktor 

bobot dari semua alternatif metoda untuk parameter yang sama harus sama 

dengan satu. Salah satu contoh logic tree yang digunakan dalam analisis resiko 
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gempa dapat dilihat pada Gambar 3.13. 

 

Gambar  3.13 Contoh Logic Tree dalam Analisis Resiko Gempa 
(Sumber: Kramer, 1996) 

 

Analisis PSHA yang dilakukan menggunakan fungsi atenuasi merujuk 

pada Peta Sumber dan Bahaya Gempa Tahun Indonesia 2017 dan pembobotan 

dari logic tree merujuk pada Irsyam et al (2010). Fungsi atenuasi yang dimaksud 

disajikan pada Tabel 3.5 sebagai berikut. 

Tabel 3.5  Korelasi Konversi Skala Magnitudo di Indonesia 

Gempa Fungsi Atenuasi Bobot 

 

Patahan 

Boore-Atkinson NGA (Boore dan Atkinson, 2014) 1/3 

Campbell-Bozorgnia NGA (Campbell dan Bozorgnia, 

2014) 

 
1/3 

Chiou-Youngs NGA (Chiou dan Youngs, 2014) 1/3 

 
Subduksi 

Interace 

BCHYDRO (Abraham dkk 2012) 1/4 

Atkinson-Boore BC rock and global source 

subduction (Atkinson dan Boore, 2003) 

 
1/4 

Zhao dkk, with variable Vs30 (Zhao dkk,2006) 1/2 

Deep 

Background 

(deep 

Interslab) 

AB interslab seismicity Cascadia region BC-rock 

condition (Atkinson-Boore, Cascadia 2003) 

 
1/3 

Geomatrix slab seismicity rock (Youngs dkk, 1997) 1/3 

AB 2003 interslab seismicity world wide data region 

BC-rock condition (Atkinson Boore, worldwide 2003) 

 
1/3 
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3.11 Deagregasi 

Metode PSHA pada dasarnya adalah metode yang digunakan untuk 

menghitung ancaman gempa, berdasarkan dari kumpulan hasil semua kejadian 

gempa yang mungkin dapat terjadi di masa datang. Kejadian gempa yang 

mungkin akan datang tidak dapat terlihat jelas dalam PSHA. Kondisi ini 

menjadikan PSHA menjadi kurang lengkap memberikan informasi tentang 

paramter gempa yaitu M dan R yang dominan dalam desain gempa. Sebagai 

pelengkap metode PSHA maka diperlukan deagregasi terhadap setiap sumber 

gempa yang dimodelkan. 

Deagregasi diperlukan dalam pemilihan data ground motion/ akselerogram 

yang sesuai dengan karakterisitik gempa di wilayah tinjauan. Deagregasi 

menghasilkan controlling magnitudo (Mcontrolling) dan controlling distance 

(Rcontrolling) gempa yang memberikan kontribusi terbesar dalam PSHA. controlling 

magnitudo (Mcontrolling) dan controlling distance yang diperoleh berdasarkan titik 

berat dari kurva deagregasi (Riza, 2010). 

3.12 Amplifikasi 

Kelas situs perlu diidentifikasi untuk merumuskan kriteria desain seismik 

suatu bangunan di permukaan tanah untuk menentukan amplifikasi besaran 

percepatan gempa puncak dari batuan dasar ke permukaan tanah untuk suatu situs. 

Profil tanah di situs harus diklasifikasikan berdasarkan profil tanah lapisan 30 m 

paling atas sesuai dengan aturan SNI 1726-2012 tentang tata cara perencanaan 

ketahanan gempa untuk struktur bangunan gedung dan non gedung yang disajikan 

pada Tabel 3.6. sebagai berikut. 

Tabel 3.6  Klasifikasi Situs 

Kelas situs Vs (m/s) N Su (Kpa) 

SA >1500 N/A N/A 

SB 750-1500 N/A N/A 

SC 350-750 >50 >100 

SD 175-350 15-50 50-100 

SE <150 <15 <50 
(sumber :  SNI 1726, 2012) 
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Nilai PGA terkoreksi (PGAM) didapatkan dengan mengalikan faktor 

amplifikasi dengan nilai PGA seperti pada Persamaan (3.19). Nilai faktor 

amplifikasi ditentukan berdasarkan kelas situs seperti yang disajikan pada Tabel 

3.7. 

 𝑃𝐺𝐴𝑀 = 𝐹𝑃𝐺𝐴  × 𝑃𝐺𝐴    (3.19) 

Dengan: 

PGAM  : nilai PGA terkoreksi 

FPGA  : koefisien situs 

 

Tabel 3.7  Koefisien Situs FPGA 

Kelas Situs PGA 0,1 PGA = 0,2 PGA = 0,3 PGA = 0,4 PGA = 0,5 

SA 0,8 0,8 0,8 0,8 0,8 

SB 1,0 1,0 1,0 1,0 1,0 

SC 1,2 1,2 1,1 1,0 1,0 

SD 1,6 1,4 1,2 1,1 1,0 

SE 2,5 1,7 1,2 0,9 0,9 
(sumber : SNI 1726, 2012) 

 

3.13 Time History 

Peak ground acceleration merupakan percepatan tanah maksimum yang 

dapat dihitung dengan menggunakan metode model empiris berdasarkan data 

historis gempa maupun menggunakan fungsi atenuasi berdasarkan jenis sumber 

gempa yang terjadi. Nilai percepatan tanah dasar tersebut akan digunakan dalam 

penetuan ground motion. 

 Riwayat waktu gempa rencana yang disetujui untuk dipakai di Indonesia 

belum ada. Salah satu pemecahan yang dapat diambil adalah memodifikasi 

rekaman riwayat waktu gempa yang sesungguhnya. Modifikasi tersebut dilakukan 

dengan menskalakan Peak Ground Acceleration (PGA) dan periode predominan 

riwayat waktu tersebut dengan PGA dan periode predominan batuan dasar dari 

wilayah tinjauan. 

 Rekaman riwayat gempa yang diambil harus memiliki magnitudo, jarak 
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patahan dan mekanisme sumber gempa yang konsisten dengan hal-hal yang 

mengontrol ketentuan gempa maksimum yang dipertimbangkan. Analisis riwayat 

waktu harus menggunakan paling sedikit dibutuhkan tiga ragam gerak tanah 

(strong ground motion) yang berbeda, seperti yang diatur dalam Pasal 11.1.3 

dalam SNI 1726- 2012. Penskalaan strong ground motion dilakukan dengan 

metode superposisi yang dicetuskan oleh Seed-Idriss (1969). 

 Metode superposisi ialah cara sederhana untuk memperoleh rekaman 

akselerogram buatan dengan durasi getar, percepatan gempa puncak dan interval 

waktu akselerogram tertentu. Langkah-langkah pembuatan aselerogram desain 

dengan metode superposisi ialah sebagai berikut: 

1. Menghitung percepatan gempa maksimum desain (ad). Percepatan gempa 

maksimum desain dapat diperoleh melalui analisis deterministik, 

probabilistik, maupun pendekatan dengan peta gempa. 

2. Menentukan periode predominan Tp dari batuan dasar menggunakan 

Persamaan (3.20) sebagai berikut. 

  𝑇𝑝 =  ∑𝑛
𝑖=1

4𝐻𝑖

𝑉𝑠 𝑖
    (3.20) 

3. Memilih aselerogram dengan karakteristik yang mendekati lokasi tinjauan 

4. Mengubah interval waktu aselerogram yang ada sehingga periode 

predominan (T1) sama dengan periode predominan batuan dasar setempat 

(Tp) menggunakan Persamaan (3.21) berikut. 

  ∆𝑡2 =  ∆𝑡1 × 
𝑇𝑝

𝑇1
    (3.21) 

5. Mengubah percepatan gempa maksimum (amax) dari aselerogram yang 

dipilih, yaitu dengan mengalikannya dengan faktor koreksi ad/ amax 

 

Contoh dari aselerogram pemodelan sumber gempa ditunjukan pada 

Gambar 3.14 sebagai berikut. 
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Gambar  3.14 Aselogram Pemodelan Sumber Gempa Megathrust 
(Sumber: Ibrahim, 2017) 

 

3.14 Analisis Stabilitas Bendungan Urugan 

3.14.1 Analisis Statik 

Pangular (1985) menyatakan analisis kestabilan bendungan tipe urugan 

memiliki cara yang sama dengan analisis kestabilan lereng. Perhitungan 

kestabilan lereng melalui rumus empiris dengan metode limit equlibrium seperti 

metode Fellinius (Ordinary), Modified Bishop, Janbu, Morgnenstern and Price 

dan Spencer. Metode kedua dengan Finite Element Method (stress deformation 

analysis) dimana pada metode tersebut memperhitungkan tegangan regangan 

tanah dan batuan, sehingga dapat memprediksikan pergerakan pada bendungan. 

Finite Element Method (FEM) biasanya digunakan pada geomteri bendungan 

yang tidak beraturan, nonlinear stress, dan complex boundary conditions. 

 Analisis stabilitas statik bendungan ini menggunakan metode FEM, 

dimana tidak dilakukan asumsi bidang longsor. Faktor keamanan didapatkan 

dengan cara mengurangi nilai kohesi c, dan sudut geser dama tanah (ϕ) secara 

bertahap hingga tanah mengalami keruntuhan. Nilai faktor keamanan, kemudian 

dihitung dengan Persamaan (3.22) sebagai berikut: 

 ∑ 𝑀𝑆𝐹 =  
𝐶

𝐶𝑟𝑒𝑑𝑢𝑐𝑒𝑑
=

𝑡𝑎𝑛

𝑡𝑎𝑛 𝑟𝑒𝑑𝑢𝑐𝑒𝑑
    (3.22) 

Dimana: 

ΣMSF  : Faktor keamanan 

c  : Kohesi sepanjang bidang gelincir (kN/m2) 
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ϕ  : Sudut geser dalam tanah (°) 

Proses perhitungan tersebut dalam diagram keruntuhan Mohr Coloumb 

yang diilustrasikan pada Gambar 3.15. berikut. 

 

Gambar  3.15 Proses Perhitungan Faktor Keamanan dalam FEM 
(Sumber: Liong, 2012) 

 

Kondisi pembeban pada analisa statik dilakukan pada tiga kondisi yaitu 

saat waduk selesai konstruksi (muka air waduk kosong), saat operasional (muka 

air waduk normal), dan saat kritis (muka air waduk banjir). Nilai safety factor 

minimum yang disyaratkan untuk analisis stabilitas statik lereng bendungan tipe 

urugan yang diatur dalam SNI 8064:2016 disajikan dalam Tabel 3.8. 

Tabel 3.8  Nilai Safety Factor Minimum 

No Kondisi Muka air waduk 

Faktor 

Keamanan 

Minimum 

1 Selesai Konstruksi Muka Air Waduk Kosong 1,3 

2 Saat Operasional Muka Air Waduk Normal 1,5 

3 Kondisi Kritis Muka Air Waduk Banjir 1,3 
(sumber : SNI 8064, 2016) 

 

3.14.2 Analisis Dinamik 

Metode dinamik adalah analisis terhadap beban gempa yang besarnya 

(intensitasnya) berubah-ubah menurut waktu. Beban gempa tersebut 
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menghasilkan tegangan normal dinamik dan tegangan geser sepanjang daerah 

yang berpotensi longsor. Hasil dari perhitungan metode dinamik adalah 

displacement. 

 Displacement adalah besaran perubahan posisi dan dimensi dari suatu 

benda. Displacement dapat diartikan sebagai perubahan kedudukan atau 

pergerakan suatu titik pada suatu benda secara absolut maupun relatif. Dikatakan 

titik bergerak absolut apabila dikaji dari perilaku gerakan titik itu sendiri dan 

dikatakan relatif apabila gerakan itu dikaji dari titik yang lain. Perubahan 

kedudukan atau pergerakan suatu titik pada umumnya mengacu kepada suatu 

sitem kerangka referensi (absolut atau relatif). 

 Kriteria displacement maksimum terutama pada puncak bendungan, 

berbeda beda untuk negara negara di dunia. Contoh dari hasil analisis 

displacement pada bendungan ditunjukkan pada Gambar 3.16 sebagai berikut. 

 

 

Gambar  3.16 Displacement pada Bendungan Tigadihaji 
(Sumber: Didiek Djarwadi, 2017) 

 

Di Indonesia aturan yang digunakan saat ini adalah displacement 

maksimum puncak bendungan adalah setengah tinggi jagaan, yaitu setengah 

antara elevasi mercu pelimpah dengan puncak bendungan. 

3.14.3 Analisis Beban Gempa  

Penelitian ini dilakukan menggunakan beberapa paramter beban gempa. 

Beban gempa yang akan digunakan untuk desain bendungan baru atau evaluasi 
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keamanan bangunan yang ada tergantung pada kondisinya. Bendungan dapat 

dievaluasi terhadap satu atau beberapa beban gempa. Analisis stabilitas 

bendungan urugan akibat beban gempa, beban gempa yang digunakan adalah 

Safety Evaluation Earthquake (SEE). Safety Evaluation Earthquake merupakan 

nama pengganti dari MDE (Maximum Design Earthquake) (ICOLD, 2016). SEE 

merupakan gempa maksimum yang mungin terjadi, yang memberikan pengaruh 

terhadap bendungan tanpa terjadi keruntuhan. Kerusakan boleh terjadi, dan 

sifatnya dapat diperbaiki secepatnya dan tidak boleh terjadi pelepasan air dari 

bendungan yang tidak terkontrol. Gempa SEE dinyatakan sebagai gempa dengan 

periode ulang 10.000 tahun apabila dihitung dengan cara PSHA dan 84 persentile 

apabila dihitung dengan DSHA. 

 Faktor-faktor yang dibutuhkan untuk evaluasi keamanan bendungan 

terhadap gempa menurut KepMen Permukiman dan Prasarana Wilayah 

360/KPTS/M/2004 tentang analisis stabilitas bendungan urugan akibat beban 

gempa antara lain: 

1. Tingkat bencana gempa di lokasi bendungan 

2. Tipe bendungan 

3. Kebutuhan fungsional 

4. Tingkat risiko bendungan dan waduk yang telah selesai 

5. Konsekuensi perkiraan risiko. 

 Hal-hal yang perlu diperhatikan berkaitan dengan pengaruh tingkat risiko 

bangunan, meliputi klasifikasi kelas risiko dan kriteria beban gempa untuk desain 

bendungan urugan. Kelas risiko beban gempa yang harus digunakan dalam desain 

ditentukan oleh tingkat risiko bangunan, seperti yang disajikan pada Tabel 3.9. 

Tabel 3.9  Kriteria Faktor Risiko Evaluasi Keamanan Bendungan 

Faktor Resiko 
Angka bobot dalam kurung 

Esktrem Moderat Tinggi Rendah 

Kapasitas (FRk) 

(106 m3) 
> 100 (6) 100-1,25 (4) 1-0,125 (2) <0,125 (0) 

Tinggi (FRt) 

(m) 
45 (6) 45-30 (4) 30-15 (2) <15 (0) 
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Faktor Resiko 
Angka bobot dalam kurung 

Esktrem Moderat Tinggi Rendah 

Kebutuhan 

evakuasi (FRe) 

(jumlah orang) 

 
>1000 (12) 

 
1000-100(8) 

 
100-1 (4) 

 
0 (0) 

Tingkat 

Kerusakan hilir 

(FRh) 

Sangat 

tinggi (12) 

Tinggi (10) 

Agak Tinggi (8) 

 
Moderat (4) 

Tidak ada 

(0) 

(sumber : KepMen Permukiman dan Prasarana Wilayah, 2004) 

 

Nilai faktor risiko total dapat dihitung dengan Persamaan (3.32):  

 𝐹𝑅𝑡𝑜𝑡 = 𝐹𝑅𝑘 + 𝐹𝑅𝑡 + 𝐹𝑅𝑒 + 𝐹𝑅ℎ    (3.23) 

 Menurut faktor risiko total, kelas risiko untuk desain seperti diuraikan 

dalam Tabel 3.10 terbagi atas kelas I (rendah), kelas II (moderat), kelas III 

(tinggi), dan kelas IV (ekstrem). Kriteria beban gempa ditinjau berdasarkan Tabel 

3.10. dan ditentukan menurut kelas risiko. Analisis dilakukan dengan dua tingkat 

gempa, seperti yang disajikan pada Tabel 3.11. 

Tabel 3.10  Kelas Risiko Bendungan dan Bangunan Air 

Faktor Resiko Total Kelas Resiko Keterangan 

(0-6) I Rendah 

(7-18) II Moderat 

(19-30) III Tinggi 

(31-36) IV Ekstrem 
(sumber : KepMen Permukiman dan Prasarana Wilayah, 2004) 

 

Tabel 3.11  Kriteria Beban Gempa untuk Desain Bendungan 

Kelas 

risiko 

dengan 

massa 

guna 

Persyaratan tanpa 

kerusakan (OBE) 

Persyaratan diperkenankan 

ada kerusakan tanpa 

keruntuhan 

(MDE) 

T (tahun) Metode analisis 
T 

(tahun) 
Metode analisis 

IV 
100-200 

ad ≥ 0,1 g 
Pseudostatik 10000 

Pseudostatik (Koef gempa) 

dan dinamik 

III 
50-100 

ad ≥ 0,1 g 
Pseudostatik 5000 

Pseudostatik (Koef gempa) 

dan dinamik 

II 
50-100 

Pseudostatik 3000 
Pseudostatik (Koef gempa) 

dan dinamik 
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Kelas 

risiko 

dengan 

massa 

guna 

Persyaratan tanpa 

kerusakan (OBE) 

Persyaratan diperkenankan 

ada kerusakan tanpa 

keruntuhan 

(MDE) 

T (tahun) Metode analisis 
T 

(tahun) 
Metode analisis 

ad ≥ 0,1 g 

I 
50-100 

ad ≥ 0,1 g 
Pseudostatik 1000 

Pseudostatik (Koef gempa) 

dan dinamik 

(sumber : KepMen Permukiman dan Prasarana Wilayah, 2004) 

 

 Beberapa parameter masukan perlu diidentifikasi untuk melakukan 

analisis metode dinamik. Parameter masukan yang dibutuhkan meliputi E 

(Modulus elastisitas), ѵ (poisson ratio), D (rasio redaman), Gmax (Modulus geser 

maksimum) dan rasio penormalan modulus geser (G/Gmax). 

 Nilai parameter Modulus elastisitas untuk berbagai jenis tanah dapat 

diketahui dengan menggunakan pendekatan yang disarankan oleh Bowles (1978) 

yang disajikan pada Tabel 3.12. 

Tabel 3.12  Nilai Perkiraan Modulus Elastisitas Tanah 

Jenis Tanah E (Mpa) 

1. Lempung  

a. Lunak 5 - 25 

b. Sedang 15 – 40 

c. Keras 50 – 100 

d. Berpasir 25 – 250 

2.     Pasir  

a. Berlanau 5 – 20 

b. Tidak padat 10 – 25 

c. Padat 50 – 80 

3. Pasir dan Kerikil  

a. Tidak padat 100-200 

b. Padat 50-150 

4. Lanau 2-20 

5. Loses 15-60 

6. Cadas 140-1400 
(sumber : Bowles, 1978) 
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Nilai parameter masukan Poisson ratio (ѵ) dengan menggunakan 

pendekatan yang diciptakan oleh Bowles, yang disajikan pada Tabel 3.13. 

Tabel 3.13  Nilai Poisson Ratio untuk Berbagai Jenis Tanah 

Jenis tanah Angka Possion 

Lempung jenuh 0,4-0,5 

Lempung tak jenuh 0,1-0,3 

Lempung berpasir 0,2-0,3 

Lanau 0,3-0,35 

Pasir 0,1-1,0 

Batuan 0,1-0,4 

Tanah (umum) 0,3-0,4 
(sumber : Bowles, 1978) 

 

Nilai modulus geser menyatakan respon suatu bahan terhadap tegangan 

geser. Modulus geser tanah dapat dianalisis berdasarkan teori teknik perambatan 

gelombang (Das, 1993). Gmax dari pengukuran lapangan berbasis metode seismik 

dapat dihitung menggunakan Persamaan (3.24) hingga Persamaan (3.26). 

 𝜌 =  
𝛾

𝑔
      (3.24) 

 𝑣𝑠 =  
√𝐺

𝜌
     (3.25) 

 𝐺𝑚𝑎𝑥 =  𝜌 × 𝑣𝑠2    (3.26) 

Dengan  

ρ  : Rapat massa (kN/m3) 

Vs  : Kecepatan Gelombang Geser (m/s) 

γ  : Berat jenis tanah (kN/m3) 

g  : Konstanta gravitasi (9,81 m/s2) 

  

Beberapa peneliti berusaha memperoleh Persamaan empiris untuk 

menentukan nilai modulus geser maksimum (Gmax), karena mahal dan sulitnya 

melakukan uji lapangan dan laboratorium, salah satunya dengan cara menemukan 

korelasi antara Gmax dan angka pori (e) melalui uji laboratorium dengan 

memperhitungkan tegangan efektif rata-rata melalui Persamaan (3.27). Penelitian 

tersebut menghasilkan fungsi angka pori seperti pada Persamaan (3.28). 
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 𝜎′𝑚 = 1 ∙ 3 [𝜎𝑣 + 2 ∙ 𝜎𝑣 (1 − 𝑠𝑖𝑛𝜑)]   (3.27) 

 𝐺𝑚𝑎𝑥 = 𝐴 × 𝐹(𝑒) × (𝜎𝑚′)𝑛    (3.28) 

Dengan 

e : Angka pori 

A,n  : Konstanta 

σ’v  : Tegangan vertikal efektif (kN/m2) 

ϕ  : Sudut geser dalam (°) 

σ’m  : Tegangan efektif rata-rata, (kN/m2) 

 Persamaan fungsi angka pori yang digunakan pada penelitian ini 

dirangkum pada Tabel 3.14. 

 

Tabel 3.14  Rangkuman Persamaan Gmax dan Angka Pori 

Peneliti A F (e) n 
Jenis Tanah yang 

Digunakan 

Hardin-Black (1968) 3270 (2,97-e)2 / (1+e) 0,6 Kaolinite 

Hardin-Richart (1963) 7000 (2,17-e)2 / (1+e) 0,5 
Pasir ottawa butir 

bulat 

Kokusho-Esashi (1981) 13000 (2,17-e)2 / (1+e) 0,55 Batu pecah 

(sumber : KepMen Permukiman dan Prasarana Wilayah, 2004) 

  

Energi dari beban dinamik (misalnya, perambatan gelombang seismik) 

jika diberikan pada media tanah, maka sebagian energinya akan terabsorpsi 

(teredam) yang menghasilkan pengurangan terhadap amplitudo gelombangnya. 

Perilaku pengurangan tersebut memberikan informasi mengenai nilai rasio 

redaman (D) tanah (Richart, 1970). 

Rollins (1998) melakukan penelitian dari bahan berbutir kasar yang diuji 

di laboratorium dengan menggunakan triaxial siklik. Hasilnya berupa Persamaan 

(2.29) dan Persamaan (2.30) mengenai empirik hubungan antara G/ Gmax dan D 

dengan regangan geser (γ). 

 𝐺/𝐺𝑚𝑎𝑥 =
1

(1.2+16(1+10−20𝛾))
    (3.29) 

 𝐷 = 0.8 + 18 (1 + 0.15𝛾−0.9)−0.75   (3.30) 

Dengan: 
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D   : Rasio redaman (%)  

G/Gmax  : Modulus Geser Penormalan  

γ   : Berat jenis tanah (kN/m3)  

  

Besaran nilai dari D dan G/Gmax dari tanah berbutir halus diperkirakan 

menggunakan metode Seed dan Idriss (1970). Grafik hubungan antara D dan 

G/Gmax dengan regangan geser γ (%) seperti terlihat pada Gambar 3.17. dan 

Gambar 3.18. 

 

Gambar  3.17 Grafik Hubungan antara G/Gmax dan Regangan Geser Tanah Berbutir Halus 
 (sumber : Seed dan Idriss, 1970) 

 

 

Gambar  3.18 Grafik Hubungan Antara Rasio Redaman dan Regangan Geser untuk 

Tanah Berbutir Halus 
 (sumber : Seed dan Idriss, 1970)
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4.0 BAB IV   METODE PENELITIAN 

METODE PENELITIAN 

4.1 Metode Penelitian 

Dalam suatu proses penelitian membutuhkan analisis yang teliti. Untuk 

dapat melakukan analisis yang baik, konsep dasar, informasi, serta alat bantu yang 

memadai. Selain itu metodologi juga sangat penting demi kelancaran menjawab 

permasalahan yang telah dirumuskan pada BAB sebelumnya. 

 Informasi penting yang diperlukan dalam penelitian ini mencakup data 

teknis bendungan serta gambar kerja (shop drawing). Data dikumpulkan 

menggunakan pengumpulan data sekunder dari pihak yang terkait. Data teknis 

bendungan dan gambar kerja dari bendungan tinjauan diperoleh dengan 

mengajukan permohonan data kepada Badan Wilayah Sungai (BWS) Provinsi 

Maluku.  

 Analisis stabilitas bendungan dilakukan dengan bantuan software 

GeoStudio untuk pemodelan bendungan untuk analisis stabilitas statik dan 

dinamik, software R-Crisis 20.0 untuk analisis seismic hazard menggunakan 

metode Probabilistic Seismic Hazard Analysis (PSHA). Hasil dari analisis dengan 

GeoStudio merupakan nilai safety factor dan deformasi bendungan. Pada akhir 

penelitian adalah penarikan kesimpulan dari hasil analisis terhadap nilai safety 

factor dan deformasi minimum yang apakah sudah memenuhi syarat keamanan. 

4.2 Data Bendungan 

Data yang dibutuhkan untuk melakukan analisis stabilitas bendungan 

metode statik dan dinamik adalah sebagai berikut: 

4.2.1 Material Bendungan 

Bendungan Way - Apu termasuk tipe bendungan urugan dengan random 

batu. Disebut demikian karena material yang dipakai sebagai pembentuk 

bendungan sebagian besar adalah urugan tanah dan pada zona-zona tertentu 

 



47 

 

 
 

diurug dengan bebatuan. Ditinjau dari penempatan dan susunan bahan yang 

membentuk tubuh bendungan maka Bendungan Way - Apu termasuk golongan 

bendungan urugan zonal tipe bendungan inti vertikal (DR. Suyonososrodarsono, 

Kensaku Takeda, Bendungan tipe Urugan). Data input bendungan digunakan 

sebagai pemodelan bendungan. Data tersebut merupakan data sekunder berupa 

parameter material tubuh dan fondasi bendungan. Secara rinci data material 

bendungan disajikan pada Tabel 4.1 dan Gambar 4.1 sebagai berikut. 

 

Tabel 4.1  Parameter Desain Material Timbunan Bendungan Way - Apu 

No Material 

Parameter 

Berat Isi 

Kering 

Berat Isi 

Basah 

Berat Isi 

Jenuh 

Sudut Geser Dalam 

  

Total Efektif 

γδ (t/m3) γτ (t/m3) γσ (t/m3) Φ Φ  

 

1 Inti 1,66 1,95 2,04 16,45 23,27  

2 Filter Halus 1,66 1,70 2,05 31,72 -  

3 Filter kasar 1,77 1,84 2,13 36,88 -  

4 Random Batu 1,71 1,82 2,07 35,43 -  

5 Rip-rap 1,30 1,35 1,80 40,00 -  

6 Pondasi Aluvial 1,92 1,98 2,21 35,65 -  

7 
Pondasi Shale-

CL 
1,70 1,93 2,06 25,25 -  

8 
Pondasi Sekis-

CM 
1,78 2,00 2,05 37,00 -  
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Gambar  4.1 Zona Material Pembentuk Bendungan Way - Apu 

 

4.2.2 Data Teknis Bendungan 

Berikut ini adalah data teknis terkait dengan Bendungan Way - Apu: 

1. Sungai    : Way – Apu. 

2. Luas daerah aliran   : 450 km2   

3. Elevasi muka air normal  : + 96,50 m  

4. Elevasi muka air banjir  : + 99,75 m  

5. Elevasi muka air rendah  : + 84,88 m  

6. Debit masuk rata-rata   : 14,80 m3 /det  

7. Debit PMF    : 3.248 m3 /det  

8. Tipe     : Zona inti tegak dengan timbunan batu  

9. Tinggi dari dasar sungai  : 51,00 meter  

10. Elevasi mercu    : +101,1 meter  

11. Panjang mercu   : 463 meter 

4.3 Peralatan Penelitian 

Untuk mempermudah dalam proses analisis data maka peneliti meng-

gunakan beberapa software, antara lain:  
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Pengumpulan Data Rekam 

Gempa tahun 1900 - 2021 

Data Rekam Gempa 

Tahun 1900 – 2021 : 

1. ISC 

2. USGS 

3. ANSS 

 

1. Potongan melintang Bendungan 

2. Index Properties Tanah : 

a. Tubuh bendungan (γd, γsat, w, 

e, c’, φ’, E dan V) 

b. Bedrock (γ, E, c, φ, v dan vs) 

 

Pengumpulan Data 

Geoteknik Bendungan  

Analisis Statik   

Declustering data rekam 

gempa   

Pemodelan Area Sumber 

Gempa   

Perhitungan SF dengan 

variasi muka air waduk   

B A 

Mulai  

1. Microsoft Office Excel, untuk membantu dalam pengolahan data gempa 

dan perhitungan input parameter material tubuh dan fondasi bendungan.  

2. Z map6.0, untuk declustering data rekam gempa.  

3. ArGIS, untuk pemodelan sumber area kejadian gempa.  

4. R-Crisis 20.0, untuk analisis resiko gempa dengan PSHA dan dis-

aggregation.  

5. GeoStudio 2018, untuk pemodelan analisis stabilitas bendungan. 

4.4 Diagram Alir Penelitian 

Tahapan yang akan diambil dalam penelitian ini akan mengikuti diagram 

alir penelitian yang dapat dilihat pada Gambar 4.2. 
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A B 

Muka 

Air 

Waduk 

Kosong 

Muka 

Air 

Waduk  

Normal  

Muka 

Air 

Waduk  

Banjir   

Fungsi Atenuasi dan Logic 

Tree   

Seismic Hazard Curved dan 

PGA   

Deagregasi   

Amplifikasi nilai percepatan 

gempa 

Analisis Dinamik 

Perhitungan Tegangan Awal 

dengan variasi muka air 

waduk 

Muka 

Air 

Waduk  

Banjir   

Muka 

Air 

Waduk  

Normal  

Muka 

Air 

Waduk 

Kosong 

Menentukan fungsi parameter dinamik 

masing-masing material 

a. Hubungan antara Gmax dengan σ’ v 

b. Hubungan antara G/Gmax dan D dengan γ 

Pemilihan Ground Motion 

Running Simulasi dengan 

Input Ground Motion 

A B 
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A B 

Safety Factor (SF) Deformasi 

Analisis Hasil dan Penarikan 

kesimpulan 

Selesai 

 

 

 

 

 

 

 

 

 

 

 

Gambar  4.2  Diagram Alir Penelitian 

4.5 Tahapan Penelitian 

Penelitian ini dilakukan melalui beberapa tahapan, yaitu: 

4.5.1 Pengumpulan Data Parameter Geoteknik Bandungan 

Input parameter tubuh bendungan yang digunakan untuk analisis stabilitas 

bendungan didapat berdasarkan data sekunder. Ketidaklengkapan data yang 

tersedia menjadikan sulit dalam pemodelan, sehingga diperlukan adanya korelasi. 

Beberapa nilai parameter tanah dengan bantuan korelasi menggunakan acuan SNI 

8064:2016 pada Tabel 3.1, antara lain kadar air (w), berat jenis tanah (Gs), 

modulus elastisitas (E), dan poisson ratio (v). Nilai parameter tanah yang lain juga 

dapat diperoleh dengan menggunakan Persamaan (3.1) hingga Persamaan (3.3) 

yaitu nilai angka pori (e), berat isi basah (γb) dan berat isi jenuh (γsat). 

4.5.2 Analisis Beban Gempa/ Probabilistic Seismic Hazard Analysis 

Tahapan proses analisis beban gempa (probabilistic seismic hazard 

analysis) adalah sebagai berikut: 

1. Pencarian Data Rekam Gempa. 

Data rekam gempa diperoleh dari katalog gempa dengan pusat titik lokasi 



52 

 

 
 

bendungan pada rentang kejadian dari tahun 1900 sampai 2020. Data 

diperoleh melalui arsip dari website USGS, ANSS dan ISC. Data tersebut 

digunakan untuk menghitung percepatan tanah maksimum. Data input 

pencarian katalog gempa adalah sebagai berikut: 

a. Latitude  : -3,5533918 

b. Longutude  : 126,8357941 

c. Magnitudo  : 4,0 – 9,0 

d. Radius  : 500 km 

e. Kedalaman  : 0-300 km. 

2. Penyeragaman Magnitudo. 

Data katalog kejadian gempa yang dikumpulkan dari berbagai sumber 

katalog masih menggunakan jenis skala magnitudo yang berbeda, 

sehingga diperlukan penyeragaman skala magnitudo menjadi momen 

magnitudo (MW) menggunakan Persamaan yang berada pada Tabel 3.5 

3. Declustering. 

Proses pemisahan kejadian gempa utama dan gempa susulan. Proses 

declustering menggunakan bantuan software Z.MAP 6.0 menggunakan 

metode Gardner dan Knopoff (1974). 

4. Analisis Kelengkapan Data Gempa. 

Data gempa yang kurang lengkap akan menyebabkan underestimated atau 

overestimated pada hasil analisis PSHA, sehingga perlu dilakukan 

pemisahan data kelengkapan gempa dari hasil decluster. Metode analisis 

kelengkapan data gempa menggunakan metode Stepp (1973). Peng-

ambilan data yang lengkap didasarkan dengan pengamatan visual terhadap 

hasil grafik. Data yang dianggap lengkap adalah data yang memiliki 

kemiringan yang konstan, jika terjadi perubahan kemiringan garis maka 

dianggap perubahan kemiringan garis tersebut batas kelengkapan data. 

Perubahan kemiringan dari grafik menandakan adanya perubahan nilai 

deviasi dari data. 
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5. Pemodelan Area Sumber Gempa. 

Data hasil analisis kelengkapan di modelkan dalam setiap area. Pemodelan 

area sumber gempa menggunakan bantuan software ArcGIS. Kejadian 

gempa dibagi menjadi beberapa interval kedalaman, yaitu 0 sampai 50 km 

untuk gempa Shallow Crustal termasuk subduksi dan patahan. Gempa 

Deep Background dimasukkan kedalam interval kedalaman 51 sampai 175 

km dan 176 sampai 300 km.  

Tiap interval kedalaman data gempa akan diambil nilai tengahnya untuk 

dijadikan satu kedalaman untuk tiap interval. Nilai kedalaman yang 

diambil untuk interval 0 sampai 50 km adalah 25 km, 112.5 km untuk 

interval 50 sampai 175 km, dan 237,5 km untuk interval kedalaman 175 

sampai 300 km. Data gempa pada tiap kedalaman akan dikelompokan 

untuk dijadikan area source berdasarkan gempa yang saling berdekatan. 

Area source akan dibentuk menjadi beberapa polygon sebagai input 

geometri untuk analisis kegempaan. Untuk gempa yang memiliki jarak 

yang berjauhan dan atau tidak bisa dikelompokan akan dijadikan satu area 

source untuk gempa deep background. Kedalaman gempa area subduksi 

dimasukan kedalam interval kedalaman 0 sampai 50 km, akan tetapi 

kedalaman yang diambil tidak ditetapkan 25 km seperti gempa patahan 

.Kedalaman gempa subduksi mengikuti geometri dari subduksi dengan 

kedalaman bagian atas subduksi 5 km dan bagian bawah 50 km. Geometri 

dari area subduksi diambil dari Peta Sumber dan Bahaya Gempa Indonesia 

Tahun 2017. Gempa yang masuk kedalam area subduksi dianggap sebagai 

gempa yang bersumber dari subduksi, sehingga tidak dilakukan 

pengelompokan. Data setiap polygon tersebut diambil koordinatnya untuk 

dimodelkan dalam R-CRISIS 20.0 untuk analisis PSHA. 

6. Perhitungan Parameter Seismik Gempa. 

Data gempa yang masuk kedalam suatu area source akan dihitung untuk 

mendapatkan nilai masukan dalam source seismicity berupa beta, lamda 

dan magnitudo maksimum. Bentuk polygon dari hasil pengelompokan 
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akan menjadi input geometry source. Perhitungan yang dilakukan untuk 

mengetahui nilai beta menggunakan Persamaan (3.16) dan lamda meng-

gunakan Persamaan (3.17). Hasil tersebut akan menjadi input dalam R-

CRISIS 20.0. 

7. Penentuan Fungsi Atenuasi dan Logic-Tree. 

Penelitian ini menggunakan fungsi atenuasi Next Ground Attenuation 

(NGA) sesuai peta gempa 2017. Fungsi atenuasi NGA dipilih karena telah 

menyesuaikan dengan data rekam gempa seluruh dunia. Logic tree 

digunakan untuk memberikan faktor pembobot yang diintreprestasikan 

sebagai kemungkinan relatif dari setiap model. Pemakaian model 

disesuikan dengan model sumber gempa yang digunakan. Gempa shallow 

crustal digunakan fungsi atenuasi patahan dan subduksi sementara untuk 

gempa deep background menggunakan fungsi atenuasi interslab. 

8. Percepatan Gempa Maksimum dan Seismic Hazard Curved. 

Analisis resiko gempa (PSHA) pada penelitian ini menggunakan bantuan 

software R-CRISIS 20.0. Pemodelan ini dibantu dengan memasukkan area 

sumber gempa, parameter seismik, fungsi atenuasi, dan logic tree. Hasil 

PSHA ini adalah percepatan maksimum batuan dasar/ bedrock (amaks). 

Percepatan gempa akan ditampilkan dengan grafik spektra yang 

menggambarkan hubungan percepatan gempa dengan waktu. Seismic 

Hazard Curved juga dimunculkan untuk mengetahui nilai probabilitas 

terlampauinya suatu intensitas atau percepatan gempa ada nilai tertentu. 

9. Deagregasi. 

Analisis deagregasi dilakukan untuk mengetahui kontribusi relatif gempa 

yang berpengaruh terhadap bendungan yang ditinjau. Tahap analisis ini 

merupakan salah satu hasil dari R-CRISIS 20.0. Hasil deagregasi ini 

memberikan nilai magnitudo dan jarak yang paling berpengaruh dari 

lokasi tinjauan. Proses deagregasi memungkinkan memunculkan beberapa 
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nilai yang memberikan kontribusi terhadap lokasi tinjauan, tetapi dipilih 

nilai yang memiliki kontribusi terbesar. 

10. Penentuan Ground Motion. 

Penentuan ground motion berdasarkan riwayat waktu yang diambil dari 

website PEER (Pacific Earthquake Engineering Research). Nilai 

magnitudo dan jarak dari hasil deagregasi digunakan sebagai input dalam 

penentuan ground motion. Hasil pencarian akan memunculkan beberapa 

ground motion yang memiliki kriteria yang mirip dengan lokasi tinjauan. 

Ground motion yang disajikan dari hasil pencarian kemudian akan dipilih 

satu untuk dijadikan input aselerogram pada pemodelan dinamik. 

11. Amplifikasi Nilai Percepatan Gempa. 

Perhitungan percepatan gempa pada permukaan tanah dengan mengalikan 

hasil PGA dari R-CRISIS 20.0 dengan faktor pengali hasil ampilifikasi. 

Faktor amplifikasi ditentukan berdasarkan site class lokasi tinjauan ber-

dasarkan nilai kecepatan rata-rata gelombang geser (𝑣�̅�). Klasifikasi tanah 

yang digunakan adalah SB dengan asumsi dasar bahwa letak tubuh 

bendungan terletak di atas lapisan tanah yang baik. sehingga didapat 

ground motion pada permukaan tanah sebagai input pada analisis stabilitas 

bendungan selanjutnya. 

 

4.5.3 Analisis Stabilitas Bendungan 

Analisis yang digunakan untuk stabilitas tubuh bendungan menggunakan 

metode statik dan dinamik. Tahap pemodelan analisis ini dilakukan dengan 

bantuan program GeoStudio 2018. Analisa stabilitas statik dan dinamik dilakukan 

pada kondisi 3 muka air waduk sesuai pada SNI 8064:2016 yaitu sebagai berikut: 

1. Muka air waduk kosong dengan elevasi + 84.88 m. 

2. Muka air waduk normal dengan elevasi + 96.50 m. 

3. Muka air waduk banjir dengan elevasi +99.75 m. 
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4.5.4 Analisis Statik  

Analisis statik merupakan pemodelan bendungan tanpa adanya beban 

gempa. Tahap analisis ini menggunakan Sigma/W dan Slope/W dalam Geosudio 

2012. Faktor keamanan minimum (safety factor) menggunkana acuan SNI 

8064:2016. Nilai minimum keamanan lereng untuk bendungan urugan disajikan 

pada Tabel 4.2. 

Tabel 4.2  Nilai Faktor Kemanan (FK) Minimum untuk Bendungan Urugan 

No Kondisi muka air waduk Elevasi (m) FK Minimum 

1 Muka Air Waduk Kosong + 84.88 1,5 

2 Muka Air Waduk Normal + 96.50 1,3 

3 Muka Air Waduk Banjir + 99.75 1,5 

 

4.5.5 Analisis Dinamik  

Analisis dinamik merupakan pemodelan bendungan menggunakan beban 

gempa. Tahap analisis ini menggunakan gabungan Sigma/W dan Quake/W dalam 

GeoStudio 2018. Analisa Dinamik dilakukan beban SEE mengacu pada aturan Pd-

T-14-2004- A. 

Hasil analisis dinamik adalah nilai displacement bendungan akibat gempa. 

Angka aman adanya displacement pada bendungan adalah setengah dari tinggi 

jagaan, dimana tinggi jagaan pada bendungan yang ditinjau sebesar 3 m. 
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5.0    BAB V   HASIL DAN PEMBAHASAN 

HASIL DAN PEMBAHASAN 

5.1 Tahapan Penelitian 

Software R-CRISIS 20.0 digunakan untuk melakukan analisis probabilitas 

bahaya gempa. R-CRISIS adalah versi terbaru dari CRISIS, merupakan solusi yang 

mendunia dan terkenal untuk melakukan analisis bahaya seismik probabilistik 

(PSHA). Program ini adalah hasil dari lebih dari 30 tahun inovasi, pengembangan 

dan peningkatan berkelanjutan, menyediakan perangkat lunak yang paling 

komprehensif, namun mudah digunakan, cocok untuk penggunaan akademik dan 

komersial. 

5.1.1 Pengumpulan Data Parameter Geoteknik Bandungan 

Penelitian ini menggunakan data rekam gempa dari 3 (tiga) sumber 

katalog yang berbeda, yaitu: 

1. United States Geological Survey (USGS), 

2. Advanced National Seismic System (ANSS),  

3. International Seismological Survey (ISC), 

 

Rekaman data gempa terbatas pada radius 500 km dari titik pusat 

Bendungan Way - Apu, dengan magnitudo 4 sampai dengan 9 yang terjadi pada 1 

Januari 1990 hingga 31 Desember 2021. Batasan yang digunakan dalam seleksi 

data gempa yang digunakan untuk penelitian ini ditunjukkan pada Tabel 5.1.  

Tabel 5.1  Parameter Bendungan Urugan 

Parameter Value 

Latitude -3,5533918 

Longitude 126,8357941 

Magnitudo 4,0 – 9,0 

Radius 500 km 
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Parameter Value 

Depth 0 - 300 km 

Time frame 1 Januari 1900 - 31 

December 2021 

 

Hasil unduhan data gempa kemudian digabungkan dan dilakukan seleksi 

terhadap gempa yang sama. Rekapitulasi rekaman data gempa yang diunduh dari 

3 (tiga) sumber katalog gempa dan gabungannya tampak pada Tabel 5.2.  

 

Tabel 5.2  Rekapitulasi Data Rekam Seismik 

Source No 

Data 

MS MB MD ML MW ME 

ISC  14,866 302 13841 53 669 1 0 

USGS  10,533 31 10082 0 3 417 0 

ANSS  11,017 36 10,325 0 4 636 16 

Combined 36,416 352 32,320 53 676 914 16 

 

5.1.2 Penyeragaman Magnitudo Gempa 

Mengingat rekaman gempa yang diperoleh dari katalog gempa tersebut 

menggunakan jenis magnitudo yang berbeda - beda, diantaranya magnitude 

momen (Mw), magnitude surface (Ms), magnitude body (Mb) dan magnitude 

local (ML) sehingga perlu diseragamkan menjadi magnitude momen (MW). 

Konversi skala magnitudo menggunakan bantuan software Microsoft 

Excel dengan Persamaan korelasi konversi antara beberapa skala magnitudo untuk 

wilayah Indonesia (Irsyam, 2010). Konversi skala magnitudo tersebut dapat 

dilihat pada Tabel 5.3.  

 

 

 

http://www.isc.ac.uk/cgi-bin/web-db-run?request=COMPREHENSIVE&out_format=CATCSV&bot_lat=&top_lat=&left_lon=&right_lon=&searchshape=CIRC&ctr_lat=-3.553&ctr_lon=126.835&radius=500&max_dist_units=km&srn=&grn=&start_year=1900&start_month=1&start_day=01&start_time=00%3A00%3A00&end_year=2020&end_month=12&end_day=31&end_time=23%3A59%3A59&min_dep=0&max_dep=300&min_mag=4&max_mag=9&req_mag_type=MB&req_mag_type=MS&req_mag_type=MW&req_mag_type=ML&req_mag_type=MD&req_mag_agcy=
https://earthquake.usgs.gov/earthquakes/search/
https://www.ncedc.org/anss/catalog-search.html
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Tabel 5.3  Konversi Skala Magnitudo 

Persamaan Konversi Range Data 

𝑀𝑤 = 0.143𝑀𝑠
2 − 1.051 𝑀𝑠 +  7.285  4.5 ≤ 𝑀𝑠 ≤ 8.6 

𝑀𝑤 = 0.114𝑀𝑏
2 − 0.556 𝑀𝑏  +  5.56 4.9 ≤ 𝑀𝑏 ≤ 8.2 

𝑀𝑤 = 0.787𝑀𝐸 + 1.537 5.2 ≤ 𝑀𝐸 ≤ 7.3 

𝑀𝑏 = 0.125𝑀𝐿
2 − 0.389𝑀𝐿 + 3.513 3.0 ≤ 𝑀𝐿 ≤ 6.2 

𝑀𝐿 = 0.717𝑀𝑑 + 1.003 3.0 ≤ 𝑀𝐿 ≤ 5.8 

 

5.1.3 Declustering Data 

Data gempa perlu dibersihkan dari pengaruh gempa susulan (Sunardi, 

2009). Proses declustering bertujuan untuk memisahkan gempa utama 

(mainshock) dari gempa – gempa susulan dan background (foreshock dan 

aftershock). Penggunaan data gempa susulan baik foreshock maupun aftershock 

menyebabkan hasil kurang sesuai (Makrup, 2013). Proses declustering 

menggunakan bantuan software zMap dengan algoritma Gardner dan Knopoff 

(Gardner dan Knopoff, 1974). 

Sebelum memproses data dengan zMap, katalog gempa perlu diformat 

sesuai dengan ketentuan input zMap: Lon; Lat; Year; Month; Day; Mw; Depth; 

Hour; Minutes; Second. Rincian penjelasan tersebut dapat dilihat pada gambar 

tangkapan layar/ screenshoot yang tampak pada Gambar 5.1.  

 

 

Gambar  5.1 Format Ketentuan Input zMap 
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Proses declustering dilakuakn dengan menggunakan software zMap dan 

dijelaskan sebagai berikut: 

1. Pada menu utama zMap v6.0, klik pada “Create or modify *.mat Datafile”. 

 

Gambar  5.2 Menu Utama zMap v6.0 

 

2. Pada jendela import datafile, pilih “EQ datafile”. 

 

Gambar  5.3 Jendela Import Datafile pada zMap. 
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3. Pilih “ASCII colomn” pada jendela Data import. 

 

 

Gambar  5.4 Jendela Data Import pada zMap. 

 

4. Muat datafile yang sudah disimpan sebelumnya dengan format yang 

sesuai dengan format yang diminta oleh aplikasi zMap v6.0. 

 

 

Gambar  5.5 Jendela General Parameter pada zMap. 
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5. Muat coast map pada zMap untuk menampilkan peta.  

 

 

Gambar  5.6 Jendela Seismicity Map pada zMap. 

 

6. Untuk melakukan declustering, pilih Ztools → Decluster the catalog → 

Decluster using Gardner & Knopoff → Go. 

 

 

Gambar  5.7 Decluster using Gardner & Knopoff pada zMap. 

 

Rekam data seismik yang telah berhasil dikumpulkan, selanjutnya 

dilakukan plotting pada peta menggunakan software zMap. Hasil plotting data 

rekam seismik ditunjukkan oleh Gambar 5.8. Pada Gambar tersebut, bagian atas 
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merupakan hasil plotting rekam data seismik sebelum dilakukan declustering, 

sedangkan sebelah kanan merupakan hasil plotting peta setelah dilakukan proses 

declustering.  

 

Gambar  5.8 Peta Plotting Rekam Data Seismik (atas: sebelum dan bawah: 

sesudah decustering) 
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Plot katalog gempa pada peta menunjukkan klaster gempa yang sangat 

padat dan masih bercampur dengan gempa gempa aftershock dan foreshock. 

Setelah dilakukan proses declustering, terlihat bahwa data gempa berkurang 

secara signifikan dan hanya menyisakan mainshock saja. Dengan katalog gempa 

yang menyisakan gempa mainshock saja, hasil pada PSHA akan lebih akurat. 

Lebih detail mengenai data plot tersebut dapat dilihat pada Tabel 5.4.  

 

Tabel 5.4 Perbandingan Katalog Seismik setelah Declustering 

Sumber 

Data Number 

sebelum 

Declustering 

Data Number 

setelah 

Declustering 

Mainshock Background 

ISC  14,866 4463 1132 3331 

USGS  10,533 3628 875 2753 

ANSS  11,017 3846 908 2938 

Combined 36,416 7023 2062 4961 

 

5.1.4 Completeness Analysis 

Setelah proses declustering data rekam gempa, proses selanjutnya adalah 

analisis kelengkapan atau completeness analysis. Dalam melakukan analisis 

PSHA, diperlukan data rekam gempa yang lengkap agar hasil analisa PSHA tidak 

overestimate ataupun underestimate. Ketidaklengkapan data rekam gempa di-

sebabkan oleh ketidakseragaman jaringan stasiun pemantauan gempa.  

Completeness analysis dilakukan dengan menggunakan metode yang 

diusulkan oleh Stepp (Stepp, 1972). Untuk melakukan analisis kelengkapan, 

model G-R (Gutenberg & Richter, 1944) diterapkan pada Frequency Magnitudo 

Distribution (FMD) dengan Persamaan (lihat Persamaan 3.12): 

 
𝑙𝑜𝑔10𝑁 = 𝑎 − 𝑏. 𝑀       

 

Dengan N adalah jumlah kumulatif dari gempa yang lebih besar atau sama 

dengan magnitudo M, a dan b adalah konstanta yang menggambarkan aktivitas 

http://www.isc.ac.uk/cgi-bin/web-db-run?request=COMPREHENSIVE&out_format=CATCSV&bot_lat=&top_lat=&left_lon=&right_lon=&searchshape=CIRC&ctr_lat=-3.553&ctr_lon=126.835&radius=500&max_dist_units=km&srn=&grn=&start_year=1900&start_month=1&start_day=01&start_time=00%3A00%3A00&end_year=2020&end_month=12&end_day=31&end_time=23%3A59%3A59&min_dep=0&max_dep=300&min_mag=4&max_mag=9&req_mag_type=MB&req_mag_type=MS&req_mag_type=MW&req_mag_type=ML&req_mag_type=MD&req_mag_agcy=
https://earthquake.usgs.gov/earthquakes/search/
https://www.ncedc.org/anss/catalog-search.html
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gempa. Konstanta a-value menunjukkan banyak gempa yang lebih besar dari 

magnitudo 0 dan b-value menunjukkan rasio gempa dengan magnitudo kecil ke 

besar.  

Dalam metode analisis yang diusulkan Stepp, data rekam gempa 

dikelompokkan menjadi beberapa rentang magnitudo. Dalam penelitian ini 

digunakan 5 (lima) kelas rentang magnitudo yang ditunjukkan oleh Tabel 5.5. 

 

Tabel 5.5 Rentang Magnitudo Seismik  

Magnitudo Range 

4 ≤ 𝑀𝑤 ≤ 5 

5 ≤ 𝑀𝑤 ≤ 6 

6 ≤ 𝑀𝑤 ≤ 7 

7 ≤ 𝑀𝑤 ≤ 8 

𝑀𝑤 ≥ 8 

 

Selain data dikelompokkan menurut rentang magnitudo, data gempa juga 

dikelompokkan berdasarkan rentang waktu dari yang terbaru. Dalam penelitian ini 

digunakan interval 10 tahun untuk setiap rentang waktu seperti tampak pada Tabel 

5.6.  

Tabel 5.6 Interval Waktu Seismik 

Rentang tahun Interval 

2015-2020 5 

2010-2020 10 

2005-2020 15 

2000-2020 20 

1990-2020 30 

1980-2020 40 

1970-2020 50 
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Rentang tahun Interval 

1960-2020 60 

1950-2020 70 

1940-2020 80 

1930-2020 90 

1920-2020 100 

1910-2020 110 

1900-2020 120 

 

Rate of occurrence untuk masing masing range magnitudo dan interval 

waktu berbeda, dimana N merupakan jumlah gempa kumulatif untuk tiap interval 

waktu dan magnitudo dan λ adalah  Rate of occurrence; N/T.  

 

Tabel 5.7 Perhitungan Magnitudo setiap Durasi Tahun 

Year Duration T Magnitudo in MW 

4 - 5 5 - 6 6 - 7 7 - 8 > 8 

N 𝜆 N 𝜆 N 𝜆 N 𝜆 N 𝜆 

2015-2020 5  0 0 292 58.4 20 4 1 0.2 0 0 

2010-2020 10 1 0.1 548 54.8 44 4.4 2 0.2 0 0 

2005-2020 15 1 0.07 790 52.67 75 5 4 0.27 0 0 

2000-2020 20 1 0.05 1039 51.95 99 4.95 4 0.2 5 0.25 

1990-2020 30 1 0.03 1473 49.1 153 5.1 6 0.2 8 0.27 

1980-2020 40 1 0.03 1733 43.33 214 5.35 9 0.23 8 0.2 

1970-2020 50 1 0.02 1847 36.94 292 5.84 10 0.2 8 0.16 

1960-2020 60 1 0.02 1933 32.22 334 5.57 12 0.2 10 0.17 

1950-2020 70 1 0.01 1937 27.67 349 4.99 16 0.23 10 0.14 

1940-2020 80 1 0.01 1939 24.24 356 4.45 17 0.21 10 0.13 

1930-2020 90 1 0.01 1947 21.63 379 4.21 20 0.22 10 0.11 
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Year Duration T Magnitudo in MW 

4 - 5 5 - 6 6 - 7 7 - 8 > 8 

N 𝜆 N 𝜆 N 𝜆 N 𝜆 N 𝜆 

1920-2020 100 1 0.01 1950 19.5 395 3.95 22 0.22 10 0.1 

1910-2020 110 1 0.01 1950 17.73 399 3.63 25 0.23 10 0.09 

1900-2020 120 1 0.01 1950 16.25 401 3.34 26 0.22 10 0.08 

 

Kemudian dihitung standar deviasi dari λ untuk masing-masing interval 

tahun dan magnitudo dengan Persamaan: 

 𝜎𝜆 =
√𝜆

√𝑇
       

 

Tabel 5.8 Perhitungan Magnitudo pada Interval Waktu 

Time 

interval 

Magnitudo in MW 

4 - 5 5 - 6 6 - 7 7 - 8 > 8 

𝜆 𝜎𝜆 𝜆 𝜎𝜆 𝜆 𝜎𝜆 𝜆 𝜎𝜆 𝜆 𝜎𝜆 

5  0 0 58.4 3.42 4 0.89 0.2 0.2 0 0 

10 0.1 0.1 54.8 2.34 4.4 0.66 0.2 0.14 0 0 

15 0.07 0.07 52.67 1.87 5 0.58 0.27 0.13 0 0 

20 0.05 0.05 51.95 1.61 4.95 0.5 0.2 0.1 0.25 0.11 

30 0.03 0.03 49.1 1.28 5.1 0.41 0.2 0.08 0.27 0.09 

40 0.03 0.03 43.33 1.04 5.35 0.37 0.23 0.08 0.2 0.07 

50 0.02 0.02 36.94 0.86 5.84 0.34 0.2 0.06 0.16 0.06 

60 0.02 0.02 32.22 0.73 5.57 0.3 0.2 0.06 0.17 0.05 

70 0.01 0.01 27.67 0.63 4.99 0.27 0.23 0.06 0.14 0.05 

80 0.01 0.01 24.24 0.55 4.45 0.24 0.21 0.05 0.13 0.04 

90 0.01 0.01 21.63 0.49 4.21 0.22 0.22 0.05 0.11 0.04 

100 0.01 0.01 19.5 0.44 3.95 0.2 0.22 0.05 0.1 0.03 

110 0.01 0.01 17.73 0.4 3.63 0.18 0.23 0.05 0.09 0.03 
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Time 

interval 

Magnitudo in MW 

4 - 5 5 - 6 6 - 7 7 - 8 > 8 

𝜆 𝜎𝜆 𝜆 𝜎𝜆 𝜆 𝜎𝜆 𝜆 𝜎𝜆 𝜆 𝜎𝜆 

120 0.01 0.01 16.25 0.37 3.34 0.17 0.22 0.04 0.08 0.03 

 

Berdasarkan pada perhitungan yang ditunjukkan pada Tabel 5.8, hasil 

perhitungan tersebut di-plot ke dalam grafik kurva 𝜎𝜆 terhadap interval waktu 

seperti ditunjukkan pada Gambar 5.9.  

 

Gambar  5.9 Kurva 𝝈𝝀 terhadap interval waktu T 

 

Menurut metode Stepp, kurva 𝜎𝜆  vs T untuk rekam data yang lengkap 

diasumsikan mendekati slope 
1

√𝑇
. Sehingga dapat ditentukan bahwa titik 

persinggungan antara kurva 𝜎𝜆  vs T dengan 
1

√𝑇
 merupakan batas interval katalog 

gempa dianggap lengkap, hasilnya seperti tampak pada Tabel 5.8. 
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Tabel 5.9 Interval Completeness dari Data Gempa 

Magnitudo 

Range 

Completeness Period 

(year) 

4 ≤ 𝑀𝑊 < 5 0 

5 ≤ 𝑀𝑊 < 6 60 

6 ≤ 𝑀𝑊 < 7 70 

7 ≤ 𝑀𝑊 < 8 30 

𝑀𝑊 ≥ 8 60 

 

Setelah mendapatkan periode yang komplit untuk masing-masing rentang 

magnitudo, dilakukan seleksi pada data rekam gempa yang akan digunakan dalam 

PSHA sesuai dengan periode lengkapnya. 

 

5.1.5 Penentuan Zona Sumber Gempa 

Sebagai salah satu input dalam analisis PSHA, selain data rekaman gempa, 

pemodelan sumber gempa harus dilakukan. Model sumber gempa dibutuhkan 

dalam analisis PSHA sebagai hubungan antara gempa dan model perhitungan 

yang digunakan untuk menentukan tingkat resiko gempa. Zona sumber gempa 

didefinisikan sebagai area yang mempunyai derajat gempa yang sama dan setiap 

titik pada zona tersebut mempunyai tingkat kemungkinan terjadinya gempa di 

masa mendatang yang sama.  

Pada penelitian ini digunakan 3 (tiga) model sumber gempa, yaitu: 

1. Zona Subduksi 

Zona Subduksi adalah zona dari kejadian gempa yang disebabkan oleh 

thrust fault, normal fault, reverse slip dan strike slip yang terjadi di sepanjang 

pertemuan lempeng. Informasi zona subduksi diperoleh dari peta sumber gempa 

yang diterbitkan oleh PusGen. Zona gempa subduksi dibatasi untuk gempa 

dengan kedalaman <50 km. Untuk gempa <50 km di luar zona subduksi masuk ke 

dalam zona gempa shallow background. 
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2. Zona Fault 

Zona Fault adalah model sumber gempa untuk gempa yang berada di zona 

patahan. Zona patahan ini diperoleh dari Peta Sumber Gempa. 

3. Zona Background 

Zona Background adalah zona untuk gempa-gempa pada zona yang belum 

teridentifikasi patahannya dengan jelas tetapi pada zona tersebut terdapat klaster 

gempa. Dalam penelitian ini zona background dibagi menjadi shallow 

background untuk kedalaman <50 km, dan deep background untuk kedalaman 50 

- 100, 100 -150, 150-200 dan 200-300 km.  

Dalam aplikasi R-CRISIS yang digunakan untuk melakukan analisis 

PSHA, model sumber gempa merupakan salah satu input untuk melakukan 

perhitungan. Dalam aplikasi ini input sumber gempa berupa shapefile zona gempa 

dan parameter gempa untuk masing-masing zona. Pembuatan shapefile zona 

sumber gempa pada penelitian ini menggunakan bantuan aplikasi ArcMap dan 

peta sumber gempa dari PusGeN. Data rekaman gempa yang sudah lengkap di-

plot pada peta lokasi dan kemudian di-overlay dengan peta sumber gempa untuk 

memudahkan melakukan digitasi zona sumber gempa.  

Dalam menentukan zona sumber gempa menggunakan software ArcMap 

mengikuti langkah-langkah sebagai berikut: 

1. Memuat peta kepulauan Indonesia sebagai basemap, shapefile Peta 

Kepulauan Indonesia diperoleh dari data batas wilayah kabupaten/kota 

2019 dukcapil. 

Klik File → Add Data → Add Data → Pilih shapefile. 
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Gambar  5.10 Pengambilan Data Peta pada Software ArcMap 

 

2. Memuat data gempa yang sudah dipisah berdasarkan kedalaman gempa 

untuk memudahkan proses pemilahan sumber gempa. 

Klik File → Add Data → Add XY Data → Pilih file data gempa. 

 

Gambar  5.11 Pengambilan Data Peta pada Software ArcMap 
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Gambar  5.12 Proses add XY Data pada Software ArcMap 

 

Pada jendela “Add XY Data”, pilih file data gempa dan kemudian pilih Lon 

untuk X Field, Lat untuk Y Field dan Mw untuk Z Field. Untuk 

geographic coordinate system menggunakan WGS 1984 sesuai dengan 

sistem koordinat yang digunakan pada katalog gempa. 

3. Membuat shapefile geometry dari sumber gempa, digunakan Peta Sumber 

dan Bahaya Gempa Indonesia Tahun 2017 terbitan PuSGen sebagai acuan. 

Untuk memuat peta sumber gempa klik File → Add Data → Add Data → 

pilih shapefile. Peta sumber gempa ini kemudian di-overlay dalam peta 

yang sudah dimuat sebelumnya. 
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Gambar  5.13 Hasil Overlay Map pada Software ArcMap 

 

Gambar  5.14 Hasil Georeferencing pada Software ArcMap 

 

Agar peta sumber gempa dapat posisi overlay peta sumber gempa sesuai 

dengan peta dasar, perlu dilakukan Georeferencing dengan cara 

menentukan 4 (empat) titik kontrol pada peta sumber gempa dan peta 

dasar sebagai referensi. 

4. Membuat shapefile dengan cara digitasi zona sumber gempa pada peta 

sumber gempa menjadi vektor. 

Klik ArcCatalog → klik kanan pada folder → New → Shapefile 
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Gambar  5.15 Proses Digitasi Zona Sumber Gempa pada ArcMap 

 

Pada jendela Create New Shapefile, beri nama shapefile yang baru dibuat, 

Feature type Polygon dan geographic coordinate system WGS 1984. 

 

Gambar  5.16 Proses Create New Shapefile pada ArcMap 
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Kemudian melakukan digitasi zona sumber gempa dengan polygon tools. 

Klik Create Features kemudian pilih polygon pada construction tools, kemudian 

membuat vektor mengikuti zona gempa pada peta sumber gempa. Shapefile untuk 

zona sumber gempa ini akan digunakan sebagai Source Geometry pada aplikasi 

R-CRISIS. 

 

Gambar  5.17 Shapefile yang Digunakan Sebagai Source Geometry 

Zona sumber gempa yang digunakan pada penelitian ini ditunjukkan pada 

peta yang tampak pada Gambar 5.18. 

 

Gambar  5.18 Peta Zona Sumber Gempa Bendungan Way - Apu 
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5.1.6 Penentuan Parameter Gempa pada Zona Sumber Gempa  

Setelah memperoleh geometri dari zona sumber gempa berupa shapefile, 

langkah berikutnya adalah penentuan parameter gempa dari setiap zona gempa. 

Untuk menentukan parameter gempa, terlebih dahulu data rekam gempa dipilah 

dan dikelompokkan sesuai dengan sumber gempanya.  

Dalam penelitian ini sumber gempa dibagi menjadi 3 (tiga): 

1. Zona Subduksi 

2. Zona fault 

3. Zona background: shallow background dan deep background 

Adapun zona subduksi, fault dan shallow background adalah untuk gempa 

yang mempunyai kedalaman kurang dari 50 km. Yang membedakan adalah zona 

gempa untuk subduksi dan fault diperoleh dari patahan dan zona megathrust yang 

sudah teridentifikasi berdasarkan peta sumber gempa PuSGeN, sedangkan 

shallow background merupakan gempa untuk wilayah yang patahan dan zona 

subduksinya belum teridentifikasi. 

Zona background dibagi berdasarkan kedalamannya, dalam penelitian ini 

zona background dibagi menjadi shallow background untuk gempa dengan 

kedalaman kurang dari 50 km, deep background untuk kedalaman 50-100 km, 

deep background untuk kedalaman 100-150 km, deep background untuk 

kedalaman 150-200 km dan deep background untuk kedalaman 200-300 km.  

Pemisahan data rekam gempa berdasarkan zona gempa ini dilakukan 

dengan bantuan aplikasi ArcMap. Langkah - langkah yang dilakukan untuk 

melakukan pemilahan data rekam gempa: 

1. Memuat data rekam gempa gabungan yang telah dilakukan analisis 

kelengkapan. 

Klik File → Add Data → Add XY Data. 

Pada jendela Add XY Data pilih Lon untuk X Field, Lat untuk Y Field dan 

Mw untuk Z Field.  
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Gambar  5.19 Proses Add XY Data  

Setelah dimuat, data rekam gempa ini kemudian di-export menjadi 

shapefile untuk memudahkan dalam pengolahan datanya. Data rekam 

gempa yang berhasil di-plot pada Peta Regional Maluku ditunjukkan pada 

Gambar 5.20.  
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Gambar  5.20 Hasil Plot Data Rekam Gempa pada Peta Regional Maluku 

 

2. Melakukan seleksi data rekam gempa sesuai dengan kedalaman gempa:  

a. Gempa dengan kedalaman kurang dari 50 km. 

b. Gempa dengan kedalaman 50 sampai dengan 100 km. 

c. Gempa dengan kedalaman 100 sampai dengan 150 km. 

d. Gempa dengan kedalaman 150 sampai dengan 200 km. 

e. Gempa dengan kedalaman 200 sampai dengan 300 km. 

Klik kanan pada data rekam gempa → Open Attribute Table. 

 

Gambar  5.21 Table Menu  
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Setelah itu klik pada Select by Attribute dan menuliskan parameter yang 

digunakan untuk memilah data rekam gempa. 

 

Gambar  5.22 Select by Attribute 

 

3. Setelah seleksi data rekam gempa dilakukan berdasarkan kelompok 

rentang kedalamannya, seleksi data tersebut di-export menjadi shapefile 

baru untuk kemudian diolah dengan aplikasi zMap untuk memperoleh 

parameter gempa yang dibutuhkan dalam proses analisis PSHA dengan 

aplikasi R-CRISIS. 

4. Setelah dilakukan clipping terhadap data gempa untuk setiap zona sumber 

gempa, kembali dilakukan pengolahan data menggunakan zMap untuk 

memperoleh parameter gempa untuk setiap zona sumber gempa. Adapun 

parameter yang diperlukan untuk analisis PSHA dengan aplikasi R-CRISIS 

adalah: MMax, b-value, a-value, a-value annual, standar deviasi a-value, 

jumlah data gempa, Mmin, dan Mc. Parameter ini akan menjadi input pada 
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R-CRISIS sebagai Source Seismicity bersama dengan shapefile yang dibuat 

menggunakan ArcMap sebagai Source Geometry. 

 

Untuk wilayah Pulau Buru, sesuai dengan Peta Sumber Gempa 2017 

PuSGeN dan melihat sebaran gempa, ada 14 area sumber gempa yang digunakan 

untuk analisa PSHA ini. Area sumber gempa ini kemudian dijadikan sebagai area 

source untuk analisa PSHA seperti pada Tabel 5.10. 

 

Tabel 5.10 Sumber Gempa di sekitar Pulau Buru yang digunakan dalam analisis PSHA 

Sumber Gempa Mmax b-value a-value a-

value 

annua

l 

σ b-

valu

e 

Jumla

h 

gempa 

Mmin Mc 

Megathrust Philippine 6,7 1,11 7,78 8,5 0,14 58 5,2 5,6 

Sorong active fault 6,6 1,27 8,4 6,65 0,1 63 5,2 5,2 

Megathrust North Banda Sea 6,8 1,46 10,3 8,5 0,08 321 5,2 5,5 

South Seram Thrust 6,8 1,58 10,3 8,56 0,2 60 5,2 5,5 

Seram Interplate 8,2 1,33 9,05 7,2 0,2 96 5,2 5,4 

Wetar back-arc 7,0 0,819 5,9 4,09 0,1 36 5,2 5,4 

Deep background 1 (50-100) 8,5 1,07 7,83 6,08 0,2 109 5,2 5,6 

Deep background 2 (50-100) 6,4 1,03 6,81 5,1 0,2 17 5,4 5,4 

Deep background 3 (50-100) 6,3 1,31 8,71 9,68 0,2 57 5,2 5,4 

Deep background 4 (50-100) 6,5 1,03 6,95 5,19 0,1 41 5,2 5,2 

Deep background 5 (100-150) 8,1 0,965 7,29 5,55 0,1 92 5,1 5,6 

Deep background 6 (100-150) 6,4 1,53 9,51 7,75 0,5 21 5,2 5,5 

Deep background 7 (150-200) 7,3 1,08 7,82 6,06 0,1 87 5,2 5,5 

Deep background 8 (200-300) 7,0 1,42 9,52 7,77 0,1 109 5,2 5,3 

 

5.1.7 PSHA dengan R-CRISIS 

R-CRISIS adalah aplikasi yang digunakan untuk menghitung tingkat 
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bahaya gempa dengan metode Probabilistic Seismic Hazard Analysis. 

Program ini pertama kali dikenalkan oleh Profesor Mario Ordaz pada 

tahun 1991 (Ordaz, M., 1991). Untuk melakukan analisis PSHA 

menggunakan aplikasi R-CRISIS dibutuhkan input sebagai berikut: 

1. Maps: bersifat opsional, adalah input untuk peta lokasi yang akan dihitung 

tingkat bahaya gempanya. Input maps berupa shapefile (.shp). 

2. Grid of sites: adalah untuk menentukan batasan wilayah yang akan 

dilakukan perhitungan tingkat bahaya gempanya. Semakin rapat grid akan 

semakin akurat analisis PSHA dan juga semakin lama waktu yang 

dibutuhkan untuk menjalankan simulasi.  

3. Source Geometry: untuk memuat zona sumber gempa. Data untuk input ini 

berupa shapefile yang telah dibuat menggunakan aplikasi ArcMap. 

4. Source Seismicity: untuk mendefinisikan parameter gempa setiap zona 

gempa.  

5. Attenuation data: untuk mendefinisikan Persamaan atenuasi yang 

digunakan dalam analisis PSHA ini. Secara umum atenuasi data 

menggambarkan hubungan probabilistik antara magnitudo, jarak sumber 

gempa ke site, dan intensitas gempa.  

6. Spectral ordinates: untuk mendefinisikan spectral acceleration ordinate. 

Dalam penelitian ini digunakan 3 (tiga) spectral ordinate, yaitu: 0s, 0.2s 

dan 1s.  

7. Global parameter: untuk mendefinisikan time frame, maximum integration 

distance, minimum triangle size dan minimum distance.  

8. Set output files: untuk menentukan letak folder dari file hasil analisis.  

9. Site effects: untuk mendefinisikan pengaruh lokal dari lokasi, baik 

amplifikasi maupun deamplifikasi pada analisis PSHA yang tergantung 

pada lokasi site, periode struktur dan ground motion level. 

 

 

Tampilan menu utama pada software R-CRISIS dapat dilihat pada Gambar 

5.23 berikut ini.  
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Gambar  5.23 Tampilan Menu Utama pada Software R-CRISIS 

 

Langkah - langkah analisis PSHA dengan aplikasi R-CRISIS adalah 

sebagai berikut: 

1. Input Maps.  

Klik Input→Maps (optional)→pada jendela Maps pilih shapefile (.shp) 

Pulau Buru→Draw→Exit. 

Hasil keluaran dari proses input maps dapat dilihat pada Gambar 5.24 di 

bawah ini. 
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Gambar  5.24 Hasil Input Maps pada Pulau Buru. 

 

2. Grid of Sites. 

Klik Input → Grid of sites → pada jendela Sites of computational hazard 

pilih “List of sites” dan muat shapefile (.shp) lokasi Bendungan Way – 

Apu → Draw → Exit. 

 

Gambar  5.25 Sites of Computation of Hazard 

Input dengan pilihan “List of sites” hanya melakukan perhitungan pada 

lokasi sites yang ada pada input, dalam penelitian ini hanya pada titik 
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lokasi bendungan Way - Apu. Untuk membuat peta tingkat bahaya gempa 

untuk wilayah sekitar Bendungan Way - Apu dapat digunakan input “Grid 

of sites” seperti Gambar 5.26 di bawah ini. Semakin rapat grid berarti 

perhitungan semakin akurat namun proses simulasi akan berjalan lebih 

lama. 

 

Gambar  5.26 Peta Tingkat Bahaya Gempa di Sekitar Bendungan 

 

3. Source Geometry. 

Klik File → Add source data from shape → pilih shapefile (.shp) source 

geometry yang telah dibuat dengan aplikasi ArcMap. 

 

 

Gambar  5.27 Proses Add Sources Data From Shape 
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Setelah shapefile termuat, klik Input → Source geometry → pada jendela 

“Geometry of the Seismic Source” masukkan parameter yang sesuai 

dengan sumber gempa seperti kedalaman seperti terlihat pada Gambar 

5.28. Proses ini kemudian diulangi untuk setiap zona sumber gempa yang 

digunakan dalam penelitian ini. 

 

Gambar  5.28 Proses Geometry of the Seismic Source 

 

4. Sources Seismicity. 

Klik Input → Source seismicity → pada jendela “Seismicity” masukkan 

parameter untuk setiap zona sumber gempa seperti tampak pada Gambar 

5.29. 

 

Gambar  5.29 Menu Input Source Seismicity 



86 

 

 
 

Jendela “Seismicity” untuk melakukan input parameter gempa masing - 

masing zona sumber gempa seperti terlihat pada Gambar 5.30. Parameter 

zona sumber gempa yang digunakan pada penelitian ini diperoleh dari data 

rekam gempa yang telah dilakukan proses clipping sesuai zonanya dan 

diolah dengan aplikasi ZMap untuk mendapatkan parameter gempanya. 

Parameter yang digunakan adalah sesuai dengan Tabel 5.11.  

  

Gambar  5.30 Menu Input Sources Seismicity 

 

Tabel 5.11 Parameter Gempa pada PSHA 

No Source name Thresho

ld 

magnitu

de (M0) 

Lambda 

(M0) 

Expecte

d value 

of Beta 

Coefficie

nt 

variation 

of Beta 

Number 

of 

magnitu

dos 

Expecte

d value 

Uncertai

nty range 

1 Deep background 

50-100 (1) 

5.6 6.08 2.46 0.2 9 8.5 0 

2 Deep background 

50-100 (2) 

5.4 5.1 2.37 0.2 9 6.4 0 

3 Deep background 

50-100 (3) 

5.4 6.95 3.02 0.2 9 6.3 0 

4 Deep background 

50-100 (4) 

5.2 5.19 2.37 0.1 9 6.5 0 

5 Deep background 

100-150 (1) 

5.6 5.55 2.22 0.1 9 8.1 0 
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No Source name Thresho

ld 

magnitu

de (M0) 

Lambda 

(M0) 

Expecte

d value 

of Beta 

Coefficie

nt 

variation 

of Beta 

Number 

of 

magnitu

dos 

Expecte

d value 

Uncertai

nty range 

6 Deep background 

100-150 (2) 

5.5 7.75 3.52 0.5 9 6.4 0 

7 Deep background 

150-200 

5.5 6.06 2.49 0.1 9 7.3 0 

8 Deep background 

200-300 

5.3 7.77 3.27 0.1 9 7 0 

9 Wetar back-arc 5.4 4.09 1.89 0.1 9 7 0 

10 Seram interplate 5.4 7.2 3.06 0.2 9 8.2 0 

11 South Seram thrust 5.5 8.56 3.64 0.2 9 6.8 0 

12 Megathrust North 

Banda Sea 

5.5 8.5 3.36 0.08 9 6.8 0 

13 Sorong active fault 5.2 6.65 2.92 0.1 9 6.6 0 

14 Megathrust Philipine 5.6 5.989 2.56 0.14 9 6.7 0 

 

5. Input attenuation data. 

Klik Input → Attenuation data → pada jendela “Attenuation Data” klik 

Add model untuk memilih Persamaan atenuasi yang digunakan seperti 

terlihat pada Gambar 5.31. 
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Gambar  5.31 Attenuation Data 

Klik Add model untuk menampilkan jendela “Attenuation Model 

Selection” dan pilih jenis model atenuasi yang digunakan seperti terlihat 

pada Gambar 5.32.  

 

Gambar  5.32 Attenuation Model Selection 
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Setelah masing-masing model atenuasi dimuat, klik “Add hybrid model” 

untuk membuat model hybrid dari beberapa Persamaan atenuasi seperti 

tampak pada Gambar 5.33. 

 

Gambar  5.33 Construct a Hybrid GMPE 

Model atenuasi yang digunakan dalam penelitian ini mengacu pada Peta 

Sumber Bahaya Gempa Indonesia Tahun 2017 (Tim Pusat Studi Gempa 

Nasional, 2017) adalah sebagai berikut: 

1. Sumber gempa shallow crustal, untuk gempa fault dan shallow 

background: 

a. Boore-Atkinson NGA 

b. Campbell-Bozorgnia NGA, 2014 

c. Chiou-Youngs NGA, 2014 

2. Sumber gempa subduksi interface, untuk gempa subduksi: 

a. BCHYDRO (Abrahamson dkk, 2012) 

b. Atkinson-Boore BC rock and global source subduction (Atkinson 

& Boore, 2003) 

c. Zhao et al, with variable Vs30, 2006 

3. Sumber gempa Benioff (deep intraslab), untuk gempa deep 

background: 

a. AB intraslab seismicity Cascadia region BC-rock condition, 2003 

b. Geomatrix slab seismicity rock, 1997 
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c. AB 2003 instraslab seismicity worldwide data region BC-rock 

condition, 2003 

Model atenuasi yang digunakan untuk masing - masing zona sumber 

gempa seperti terlihat pada Tabel 5.12. 

 

Tabel 5.12 Parameter Gempa pada PSHA 

Sumber Gempa Source Model Attenuation Model 

Megathrust Philippine Subduction Megathrust Hybrid b(1) / b(2) / b(3) 

Sorong active fault Fault Hybrid a(1) / a(2) / a(3) 

Megathrust North Banda 

Sea 

Subduction Megathrust Hybrid b(1) / b(2) / b(3) 

South Seram Thrust Subduction Hybrid b(1) / b(2) / b(3) 

Seram Interplate Fault Hybrid a(1) / a(2) / a(3) 

Wetar back-arc Fault Hybrid a(1) / a(2) / a(3) 

Deep background 1 (50-

100) 

Deep background Hybrid c(1) / c(2) / c(3) 

Deep background 2 (50-

100) 

Deep background Hybrid c(1) / c(2) / c(3) 

Deep background 3 (50-

100) 

Deep background Hybrid c(1) / c(2) / c(3) 

Deep background 4 (50-

100) 

Deep background Hybrid c(1) / c(2) / c(3) 

Deep background 5 

(100-150) 

Deep background Hybrid c(1) / c(2) / c(3) 

Deep background 6 

(100-150) 

Deep background Hybrid c(1) / c(2) / c(3) 

Deep background 7 

(150-200) 

Deep background Hybrid c(1) / c(2) / c(3) 

Deep background 8 

(200-300) 

Deep background Hybrid c(1) / c(2) / c(3) 
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6. Input Spectral Ordinate. 

Klik Input → Spectral ordinates → pada penelitian ini digunakan 3 (tiga) 

spectral ordinate yaitu: 0 detik untuk perhitungan PGA, 0,2 detik dan 1 

detik untuk perhitungan spectral acceleration seperti tampak pada Gambar 

5.34. 

 

Gambar  5.34 Intensity for Each Spectral Ordinate 

 

7. Input Global Parameter. 

Klik Input → Global parameter → pada jendela “Global parameter” 

masukkan Time frame yang akan digunakan dalam perhitungan PSHA ini 

seperti terlihat pada Gambar 5.35.  
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Gambar  5.35 Input Global Parameter 

Menentukan Periode Ulang / Return Period (T) gempa: 

 

𝑅𝑁 = 1 − (1 − 𝑅𝑎)𝑁      

Dimana: 

RN = Probability of Exceedance / Resiko gempa dalam % 

Ra = Annual rate 1/T 

N = Masa guna bangunan 

T = Return Period / Periode ulang 

 

 

Hasil perhitungan return period atau periode ulang/ (T) ditampilkan pada 

Tabel 5.13. 

Tabel 5.13 Parameter Gempa pada PSHA 

Periode ulang 

(tahun) 

RN / Resiko 

gempa (%) 

N / Masa guna 

banguna 

(tahun) 

T / Return 

period 

Ra / Annual rate 

50 20% 10 45 0.022067 
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Periode ulang 

(tahun) 

RN / Resiko 

gempa (%) 

N / Masa guna 

banguna 

(tahun) 

T / Return 

period 

Ra / Annual rate 

100 10% 10 95 0.010481 

200 5% 10 195 0.005116 

500 10% 50 475 0.002105 

1000 7% 75 1033 0.000967 

2500 2% 50 2475 0.000404 

5000 2% 100 4950 0.000202 

10000 1% 100 9950 0.0001 

 

8. Set Output files: input ini untuk menentukan letak folder untuk menyimpan 

hasil analisis. 

9. Menjalankan simulasi:  

Klik Run → Validate and run → Proses simulasi akan berjalan seperti 

tampak pada Gambar 5.36. Selanjutnya apabila sudah selesai, jendela 

“Computing Hazard” akan menampilkan informasi file yang dihasilkan 

seperti tampak pada Gambar 5.37. 

 

Gambar  5.36 Proses Running Simulasi PSHA dengan R-CRISIS 
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Gambar  5.37 Informasi Keluaran dari Simulasi PSHA dengan R-CRISIS 

 

10. Hasil simulasi dapat dilihat dari hazard map yang di-generate secara 

otomatis oleh aplikasi R-CRISIS dengan cara klik Hazard → See hazard 

map. 

 

Gambar  5.38 Hazard Map Hasil Simulasi PSHA dengan R-CRISIS 
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11. Untuk memperoleh hasil perhitungan PSHA pada lokasi bendungan dapat 

melakukan export data untuk masing - masing time frame dan Exceedance 

probabilistic seperti tampak pada Gambar 3.39 dan Tabel 5.14. 

 

 

Gambar  5.39 File Hasil Simulasi PSHA dengan R-CRISIS 

 

Tabel 5.14 Hasil Perhitungan PSHA untuk Titik Lokasi pada Bendungan Way - Apu 

Return 

period 

PE TF PGA (0s) SA 0,2s SA 1s 

50 0,2 10 0,153 0,353 0,099 

100 0,1 10 0,206 0,475 0,129 

200 0,05 10 0,258 0,581 0,166 

500 0,1 50 0,335 0,733 0,216 

1000 0,07 75 0,437 0,924 0,263 

2500 0,02 50 0,545 1,173 0,333 

5000 0,02 100 0,645 1,368 0,401 

10000 0,01 100 0,767 1,6 0,476 
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5.1.8 Peta Peak Ground Acceleration dan Spectral Response Acceleration 

Peta PGA dan Spectral Response Acceleration adalah peta yang memuat 

informasi tingkat bahaya gempa pada wilayah yang ditentukan, dalam hal ini 

adalah Pulau Buru. Untuk membuat peta bahaya gempa Pulau Buru, data yang 

diperlukan adalah hazard map yang diperoleh dari hasil perhitungan PSHA untuk 

Pulau Buru dengan aplikasi R-CRISIS. Data perhitungan PSHA ini kemudian 

diolah dengan menggunakan aplikasi ArcMap untuk di-plot ke dalam peta Pulau 

Buru dan menambahkan informasi contour dari nilai PGA dan Spectral response 

acceleration.  

Berikut ini adalah langkah-langkah pembuatan peta sumber dan bahaya 

gempa: 

1. Memuat shapefile Pulau Buru sebagai peta dasar. 

Klik File → Add Data → pilih shapefile Pulau Buru seperti pada Gambar 

5.40 dan hasilnya tampak pada Gambar 5.41. 

 

Gambar  5.40 Memuat Shapefile Pulau Buru 
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Gambar  5.41 Tampilan Output Shapefile Pulau Buru 

 

2. Memuat data PGA dan Spectral Acceleration hasil simulasi dengan 

software R-CRISIS 

Klik File → Add Data → Add XY Data → pilih file data hasil PSHA 

seperti tampak pada Gambar 5.42.  
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Gambar  5.42 Proses Memuat Data PGA dan Spectral Acceleration 

 

 

Gambar  5.43 Keluaran Data PGA dan Spectral Acceleration 
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Pada jendela Add XY Data masukkan Lon sebagai X Field, Lat sebagai Y 

Field dan Intensity sebagai Z Field, serta WGS 1984 sebagai Geographic 

Coordinate System. Data ini akan termuat sebagai grid titik - titik 

perhitungan PSHA dengan aplikasi R-CRISIS seperti ditunjukkan pada 

Gambar 5.43. 

3. Interpolasi data PSHA dan membuat kontur. 

Untuk melakukan interpolasi digunakan Tool Spline Interpolation seperti 

ditunjukkan pada Gambar 5.44 kiri. Hasil interpolasi kemudian diubah 

intervalnya menjadi 0,02 dan dilakukan clipping dengan Peta Pulau Buru 

sebagai mask seperti yang ditunjukkan pada Gambar 5.44 kanan. 

 

Gambar  5.44 Interpolasi data PSHA (kiri: Spline tool, kanan: mask Pulau Buru) 

 

Gambar  5.45 Interpolasi data PSHA (kiri: Contour tool, kanan: mask Pulau 

Buru) 
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Untuk menambahkan garis kontur dan label digunakan tools Surface → 

Contour dengan hasil interpolasi sebagai input raster dan interval 0,02 

seperti tampak pada Gambar 5.45 kiri. Hasil Peta PGA setelah 

ditambahkan garis kontur dapat dilihat pada Gambar 5.45 kanan. 

 

Hasil peta PGA terkait parameter seismik pada Pulau Buru dimana 

Bendungan Way - Apu berada ditunjukkan oleh Gambar 5.46 – Gambar 5.52. 

 

 

Gambar  5.46 Peta Percepatan Puncak Probabilitas Terlampaui 20% dalam 10 

Tahun 
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Gambar  5.47 Peta Percepatan Puncak Probabilitas Terlampaui 10% dalam 10 

Tahun 

 

 
Gambar  5.48 Peta Percepatan Puncak Probabilitas Terlampaui 10% dalam 50 

Tahun 
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Gambar  5.49 Peta Percepatan Puncak Probabilitas Terlampaui 7% dalam 75 

Tahun 

 

 

Gambar  5.50 Peta Percepatan Puncak Probabilitas Terlampaui 2% dalam 50 

Tahun 
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Gambar  5.51 Peta Percepatan Puncak Probabilitas Terlampaui 2% dalam 100 

Tahun 

 

 

Gambar  5.52 Peta Percepatan Puncak Probabilitas Terlampaui 1% dalam 100 

Tahun 
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5.2 Analisis Stabilitas Bendungan 

Software R-CRISIS digunakan untuk melakukan analisis probabilitas 

bahaya gempa. R-CRISIS adalah versi terbaru dari CRISIS, merupakan solusi 

yang mendunia dan terkenal untuk melakukan analisis bahaya seismik 

probabilistik (PSHA). Program ini adalah hasil dari lebih dari 30 tahun inovasi, 

pengembangan dan peningkatan berkelanjutan, menyediakan perangkat lunak 

yang paling komprehensif, namun mudah digunakan, cocok untuk penggunaan 

akademik dan komersial. 

Analisis stabilitas bendungan dibagi menjadi 2 (dua) bagian, yaitu analisis 

statis dan analisis dinamik. Pada analisis statis, kondisi bendungan, baik tanah 

maupun aliran air dalam kondisi ajeg dan mengabaikan perubahan yang terjadi 

terhadap perubahan waktu. Dalam kondisi sebenarnya, kondisi ini tidak akan 

pernah tercapai karena akan selalu ada perubahan aliran air. Pengaruh gempa yang 

dihitung dalam analisis statis merupakan parameter gempa yang bersifat statis 

yang diperoleh dari analisis PSHA. Analisis dinamik merupakan analisis yang 

mepertimbangkan perubahan keadaan bendungan dan aliran air terhadap 

perubahan waktu. Dalam analisis dinamik, beban gempa yang digunakan juga 

berupa beban gempa dinamik.  

Dalam penelitian ini, baik simulasi analisis statik maupun dinamik 

dilakukan dengan bantuan aplikasi GeoStudio 2018. Analisis SEEP/W dan 

SLOPE/W digunakan untuk perhitungan stabilitas statis lereng bendungan 

sedangkan untuk stabilitas dinamik selain SEEP/W dan SLOPE/W juga digunakan 

SIGMA/W. 

5.2.1 Data Bendungan  

Bendungan Way - Apu merupakan bendungan tipe urugan dengan zona 

inti vertikal. Dalam analisis stabilitas bendungan, data yang dibutuhkan untuk 

perhitungan stabilitas adalah: 

1. Gambar desain Bendungan Way - Apu untuk digunakan sebagai acuan 

dalam membuat model bendungan pada aplikasi GeoStudio.  
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2. Data material bendungan digunakan sebagai input dalam perhitungan 

stabilitas lereng bendungan. Data material termasuk parameter setiap 

material penyusun tubuh bendungan.  

3. Data operasional bendungan seperti ketinggian muka air bendungan. 

 

Gambar desain Bendungan Way - Apu yang digunakan dalam penelitian ini dapat 

dilihat pada Gambar 5.53. Gambar desain bendungan ini kemudian digambarkan 

ulang ke dalam format CAD dengan bantuan aplikasi AutoCAD dengan tujuan 

mempermudah dalam menggambar model bendungan dengan akurat. Pemodelan 

dua dimensi juga dapat dilakukan langsung di dalam aplikasi GeoStudio, namun 

keterbatasan fungsi pada GeoStudio menyebabkan pemodelan yang akurat lebih 

sulit dilakukan. Data material bendungan yang digunakan terlihat pada Tabel 

5.15.  

Tabel 5.15 Data Material Bendungan Way - Apu  

No Material 

Parameter 

Berat isi 

kering 

Berat isi 

basah 

Berat isi 

jenuh 
Sudut Geser dalam 

ɣd (t/m3) ɣt (t/m3) ɣs (t/m3) 
Total  

φ ( ° ) 

Efektif  

φ’ ( ° ) 

1 Inti tanah 1,66 1,95 2,04 16,45 23,27 

2 Filter halus 1,66 1,70 2,05 31,72 - 

3 Filter kasar 1,77 1,84 2,13 36,88 - 

4 Random batu 1,71 1,82 2,07 35,43 - 

5 Rip-rap 1,30 1,35 1,80 40,00 - 

6 Pondasi aluvial 1,92 1,98 2,21 35,65 - 

7 Pondasi Shale-CL 1,70 1,93 2,06 25,25 - 

8 Pondasi Sekis-

CM 

1,78 2,00 2,05 37,00 - 
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Gambar  5.53 Desain Bendungan Way - Apu 
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Untuk dapat melakukan analisis baik statik maupun dinamik diperlukan data 

ketinggian muka air bendungan pada saat operasional. Pada penelitian ini 

digunakan data muka air bendungan seperti tampak pada Tabel 5.16. 

 

Tabel 5.16 Ketinggian Muka Air Bendungan 

No Kondisi Muka Air Elevasi (m) 

1 Muka Air Normal  96,50 

2 Muka Air Banjir 98,80 

3 Muka Air Minimal 79,75 

 

5.2.2 Kelas Resiko 

Kelas resiko Bendungan Way - Apu dapat diketahui dengan merujuk pada 

nota perhitungan dari konsultan PT. Indra Karya yang sesuai dengan Tabel 3.9. 

dan besarnya faktor resiko dihitung berdasarkan Persamaan 3.23. Untuk 

Bendungan Way - Apu, perhitungan faktor resiko disajikan dalam Tabel 5.17 

berikut ini.  

Tabel 5.17 Perhitungan Kelas Risiko Bendungan Way - Apu 

No. Pengaruh Resiko Ukuran Faktor 

Resiko 

Bobot 

1 Kapasitas (106 m3) 59,73 FRk 4 

2 Tinggi 72 FRt 6 

3 Kebutuhan evakuasi 

(jumlah orang) 

>1000 FRe 12 

4 Tingkat kerusakan 

hilir 

Sangat Tinggi (Jumlah 

Keluarga >200) 

FRh 12 

   FRtot 34 

   Klasifika

si 

IV 

(Ekstrem) 

(Nota Perhitungan PT Indra Karya, 2021) 
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Berdasarkan perhitungan kelas risiko di atas, Bendungan Way - Apu 

termasuk ke dalam klasifikasi kelas risiko IV (ekstrem). Untuk kategori ini, 

berdasarkan Tabel 3.11, metode analisis yang digunakan adalah: 

1. Persyaratan tanpa kerusakan gempa atau Operational Basis Earthquake 

(OBE) digunakan analisis pseudostatik dengan periode ulang gempa T = 

100 tahun dan persyaratan faktor keamanan FKmin ≥ 1,20. 

2. Persyaratan diperkenankan ada kerusakan tanpa keruntuhan atau 

Maximum Design Earthquake (MDE) digunakan analisis pseudostatik 

dengan periode ulang gempa T = 10.000 tahun dan persyaratan faktor 

keamanan FKmin ≥ 1.  

3. Analisis dinamik dilakukan apabila persyaratan faktor keamanan untuk 

gempa MDE tidak terpenuhi.  

5.2.3 Koefisien Gempa Bumi 

Berdasarkan analisis PSHA yang telah dilaksanakan sebelumnya, untuk 

lokasi Bendungan Way - Apu mempunyai koefisien gempa PGA (Peak Ground 

Acceleration) sebagaimana terlihat pada Tabel 5.18 di bawah ini. 

Tabel 5.18 Koefisien Gempa PGA  

No. 
Periode ulang 

(tahun) 

Percepatan 

puncak di 

batuan dasar 

/ PGA 

(g) 

Respon 

Spektrum 0,2 

detik 

(g) 

Respon 

Spekturm 1 

detik 

(g) 

1. 50 0,153 0,353 0,099 

2. 100 0,206 0,475 0,129 

3. 200 0,258 0,581 0,166 

4. 500 0,335 0,733 0,216 

5. 1.000 0,437 0,924 0,263 

6. 2.500 0,545 1,173 0,333 

7. 5.000 0,645 1,368 0,401 



109 

 

 
 

8. 10.000 0,767 1,600 0,476 

 

Sesuai dengan hasil perhitungan faktor resiko, koefisien gempa yang 

digunakan untuk simulasi adalah koefisien T=100 tahun (Operational Basis 

Earthquake / OBE) dan T = 10,000 tahun (Maximum Design Earthquake / MDE). 

Koefisien gempa untuk lokasi Bendungan Way - Apu terlihat pada Tabel 5.19.  

 

Tabel 5.19 Koefisien Gempa PGA pada Bendungan Way - Apu 

Periode Ulang Gempa Koefisien Gempa / Nilai PGA 

100 tahun 0,206 

10.000 tahun 0,767 

 

Dalam analisis stabilitas bendungan, koefisien gempa ini harus di-

modifikasi sesuai dengan fungsi kedalaman dari puncak bendungan agar dapat 

menggambarkan “Efek Cambuk” yang terjadi ketika bendungan mendapat 

pengaruh dari gempa, yaitu semakin tinggi tempat yang ditinjau akan semakin 

besar efek guncangan gempanya.  

Persamaan yang digunakan untuk menghitung koefisien gempa di 

permukaan terkoreksi adalah (lihat Persamaan): 

 

𝐾𝑜 = ⍺2 ×  𝐾ℎ      

Dengan: 

Ko  : koefisien gempa terkoreksi dengan di permukaan tanah 

⍺2  : koreksi untuk jenis struktur; bendungan urugan ⍺2= 0.5 

Kh  : koefisien gempa sesuai dengan periode ulang gempa T 

 

Sehingga perhitungan untuk koefisien gempa terkoreksi pada penelitian ini: 

Untuk gempa OBE T=100 tahun 

Ko= 0.5 x 0.206 

Ko= 0.103 



110 

 

 
 

Untuk gempa MDE T=10,000 tahun 

Ko= 0.5 x 0.767 

Ko= 0.384 

 

Kemudian menentukan koefisien gempa termodifikasi sesuai fungsi kedalaman 

adalah dengan Persamaan berikut ini: 

Untuk 0 ＜ y/H ≤ 0,4 

 

𝑘 = 𝑘𝑜 × (2,5 − 1,85 × 𝑦/𝐻)     

 

dan untuk 0,4 ＜ y/H ≤ 1,0 digunakan Persamaan 

 

𝑘 = 𝑘𝑜 × (2,0 − 0,6 × 𝑦/𝐻)     

 

Setelah dilakukan perhitungan menggunakan Persamaan di atas, diperoleh 

koefisien gempa termodifikasi sesuai dengan fungsi kedalaman yang disajikan 

dalam Tabel 5.20.  

 

Tabel 5.20 Koefisien Gempa Termodifikasi Bendungan Way - Apu 

Periode 

ulang gempa 

T 

K0 

K pada y/H 

0.25 0.50 0.75 1.00 

100 (OBE) 0.103 0.201 0.175 0.16 0.144 

10,000 

(MDE) 

0.384 0.782 0.653 0.595 0.538 

 

Koefisien di atas merupakan koefisien gempa untuk arah horisontal 

sedangkan dalam analisis stabilitas bendungan juga perlu dihitung koefisien 

gempa vertikal. Untung menghitung koefisien gempa vertikal biasanya digunakan 

50% dari koefisien gempa horisontal sehingga dalam penelitian ini, digunakan 

koefisien gempa vertikal yang dihitung berdasarkan Persamaan, KV = K x 0.5 dan 

disajikan dalam Tabel 5.21.  
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Tabel 5.21 Koefisien Gempa Termodifikasi Bendungan Way - Apu 

Periode ulang gempa 

T 

KV pada y/h 

0,25 0,50 0,75 1,00 

100 (OBE) 0,105 0,088 0,08 0,072 

10.000 (MDE) 0,391 0,327 0,298 0,269 

 

5.2.4 Analisis Statik Lereng Bendungan 

Menurut Pd T-14-2004-A tentang analisis stabilitas bendungan tipe urugan 

akibat beban gempa, analisis stabilitas statik bendungan dilakukan untuk kondisi 

berikut: 

1. Selesai masa konstruksi. 

2. Aliran langgeng (steady-state seepage) 

3. Pengoperasian waduk (surut cepat) 

4. Kondisi darurat 

 

Pada penelitian ini, kondisi waduk yang dihitung dalam analisis stabilitas 

lereng bendungan adalah:  

1. Selesai masa konstruksi kondisi air kosong 

2. Kondisi air langgeng muka air normal pada elevasi +96,5 m 

3. Kondisi air langgeng muka air banjir pada elevasi +98,8 m 

4. Kondisi pengoperasian surut cepat dari muka air normal elevasi +96,5 m 

ke muka air minimum elevasi +79,75 m 

 

Analisa stabilitas bendungan menggunakan program GeoStudio 2018 R2. 

Metode analisis yang digunakan adalah SEEP/W dan SLOPE/W. SEEP/W 

digunakan untuk memperoleh nilai pore water pressure dan garis freatik pada 
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tubuh bendungan. Output dari SEEP/W digunakan dalam analisa SLOPE/W untuk 

memperoleh nilai faktor keamanan bendungan. Analisis stabilitas statik 

Bendungan Way - Apu secara garis besar dilakukan sesuai dengan Tabel 5.22. 

 

Tabel 5.22 Koefisien Gempa Termodifikasi Bendungan Way - Apu 

No Kondisi Analisis Keterangan Hasil 

1 Kondisi setelah masa 

konstruksi dengan air 

kosong 

Slope/W Tipe Morgenstern-

Price tanpa PWP 

dan menggunakan 

entry & exit untuk 

slip surface 

Faktor 

Keamanan 

2 Kondisi aliran steady-state  Seep/W Tipe steady state 

dan boundary 

condition sesuai 

Muka Air Normal 

Pore Water 

Pressure / garis 

freatik 

Slope/W Tipe Morgenstern-

Price dengan PWP 

dari Seep/W 

Faktor 

keamanan 

4 Kondisi surut cepat / rapid 

drawdown  

Seep/W Tipe Steady-State Initial PWP 

Condition 

Seep/W Tipe Transient 

dengan boundary 

condition level with 

time 

PWP pada time 

frame sesuai 

dengan 

kecepatan 

drawdown 

Slope/W Dengan PWP dari 

Seep/W transient 

Faktor 

Keamanan 

 

Pada kondisi masa selesai konstruksi/ air kosong (nomor 1 dan 2 ) 

digunakan program SLOPE/W dengan tipe Morgenstern-Price tanpa PWP. Slip 

surface sisi lereng hulu dan hilir menggunakan entry and exit yang dibedakan 

arahnya. Analisis statis bendungan pada masa selesai konstruksi/ air kosong 

mengikuti beberapa langkah dibawah ini, yaitu: 

1. Membuat analisis baru pada SLOPE/W dengan tipe Morgenstern-Price, 

tanpa Pore Water Pressure dan slip surface dengan option entry and exit. 
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Klik Define Analysis → Add → Seep/W Analysis→Steady-state seperti 

pada Gambar 5.54.  

 

 

Gambar  5.54 Jendela Define Analysis 

 

2. Input material pada region bendungan dan parameter sesuai data 

Untuk melakukan input material klik Define→Materials sesuai dengan 

Gambar 5.55. Sedangkan untuk melakukan input material pada region klik 

Draw→Material. 
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Gambar  5.55 Jendela Define Materials 

Beberapa material yang digunakan dalam simulasi perhitungan analisis 

SLOPE/W Serta gambar masing masing zonal ditunjukkan oleh Tabel 5.23 

dan Gambar 5.56.  

 

Tabel 5.23 Material dalam Simulasi Analisis Slope/W 

No

. 
Nama material Material model 

Unit 

weight 

(kN/m³) 

φ(o) 
Cohesion 

(kPa) 

1 Zona 1 (Tanah Inti) Mohr-Coulomb 19,13 16,45 37,67 

2 Zona 2 (Filter 

Halus) 

Mohr-Coulomb 16,68 31,72 0 

3 Zona 3 (Filter 

Kasar) 

Mohr-Coulomb 18,05 36,88 0 

4 Zona 4 (Random 

Batu) 

Mohr-Coulomb 17,85 35,43 13,5378 

5 Zona 5 (Rip-rap) Mohr-Coulomb 13,24 40 0 

6 Zona 6 (Concrete 

block) 

Mohr-Coulomb 19,42 35,65 0 

7 Zona 7 (Pondasi 

Shale-CL) 

Mohr-Coulomb 18,93 25,25 0 
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8 Zona 8 (Pondasi 

Sekis-CM) 

Mohr-Coulomb 19,62 37 62,78 

 

 

Gambar 5.56 gambar masing masing zonal bendungan Way-Apu 

3. Untuk kondisi tanpa gempa, seismic load dikosongkan.  

4. Untuk kondisi dengan gempa OBE, seismic load diisikan dengan koefisien 

gempa horizontal dan vertikal dengan ketinggian masing-masing (y/h = 

0,25; 0,50; 0,75; 1,00). 

5. Running simulation untuk mendapatkan angka faktor keamanan untuk 

setiap kondisi. 

 

Untuk analisis kondisi dengan aliran steady-state muka air normal, muka 

air banjir dan muka air minimum, sebelum analisis stabilitas dengan SLOPE/W 

terlebih dahulu dilakukan analisis SEEP/W steady-state untuk mendapatkan garis 

freatik pore water pressure yang digunakan pada analisis SLOPE/W. Prosedur 

simulasinya adalah sebagai berikut: 

1. Membuat analisis baru untuk SEEP/W dengan tipe steady state. 
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Gambar  5.56 Jendela Pembuatan Analisis Baru untuk SEEP/W 

2. Menentukan fungsi hidrolis untuk material: Hydraulic conductivity dan  

Volume Water Content. 

 

Gambar  5.57 Jendela Define Volume Water Content Function 

Hydraulic Conductivity Function: 

a. Blended Clay Core 

Type    : Hyd. K Data Point Function 
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Estimation Method  : Fredlund-Xing-Huang 

Vol. Water Content Fn : Blended Clay Core 

Saturated Kx   : 1,08 x 10-7 m/sec 

b. Hydraulic Fine Sand 

Type    : Hyd. K Data Point Function 

Estimation Method  : Fredlund-Xing-Huang 

Vol. Water Content Fn : Blended Clay Core 

Saturated Kx   : 10-6  m/sec 

c. Coarse Sand 

Type    : Hyd. K Data Point Function 

Estimation Method  : Fredlund-Xing-Huang 

Vol. Water Content Fn : Blended Clay Core 

Saturated Kx   : 0,001 m/sec 

d. Gravel Fill 

Type    : Hyd. K Data Point Function 

Estimation Method  : Fredlund-Xing-Huang 

Vol. Water Content Fn : Blended Clay Core 

Saturated Kx   : 7,52 x 10-6 m/sec 

 

3. Input material untuk SEEP/W 

a. Zona 1 (Tanah Inti) 

Material Model  : Saturated/Unsaturated 

Vol. Water Content Fn.  : Blended Clay Core 

Hyd. Conductivity Fn.  : Blended Clay Core 

b. Zona 2 (Filter Halus) 

Material Model  : Saturated/Unsaturated 

Vol. Water Content Fn.  : Filter Sand 

Hyd. Conductivity Fn.  : Hydraulic Fine Sand 

c. Zona 3 (Filter Kasar) 

Material Model  : Saturated/Unsaturated 

Vol. Water Content Fn.  : Filter Sand 
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Hyd. Conductivity Fn.  : Coarse Sand 

d. Zona 4 (Random batu) 

Material Model  : Saturated/Unsaturated 

Vol. Water Content Fn.  : Gravel Fill 

Hyd. Conductivity Fn.  : Gravel Fill 

e. Zona 5 (Rip-rap) 

Material Model  : Saturated Only 

Sat. X-Conductivity  : 0,01 m/sec 

f. Zona 6 (Concrete Block) 

Material Model  : Saturated Only 

Sat. X-Conductivity   : 10-11 m/sec 

g. Zona 6 (Pondasi Shale-CL) 

Material Model  : Saturated Only 

Sat. X-Conductivity   : 5 x 10-7 m/sec 

h. Zona 6 (Concrete Sekis-CM) 

Material Model  : Saturated Only 

Sat. X-Conductivity   : 6,62 x 10-9 m/sec 

 

4. Define boundary untuk analisa SEEP/W. Dalam analisis ini digunakan 

boundary conditions sebagai berikut:  

a. Water Total Head untuk level muka air. 

b. Water Pressure Head untuk Zero pressure. 
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Gambar  5.58 Jendela Define Boundary Condition 

 

 

 
Gambar  5.59 Jendela Draw Boundary Condition 

 

 

5. Start solve manager untuk menjalankan simulasi dan mendapatkan output 

berupa garis freatik yang akan digunakan pada analisis SLOPE/W 

selanjutnya. 
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6. Analisis SEEP/W ini dibuat untuk setiap Water Level: Normal Water Level 

+96,5m; Low Water Level +84,88 dan Flood Water Level + 98,8m. 

Analisis SLOPE/W dilakukan untuk setiap kondisi yang telah ditentukan 

dalam penelitian ini, yaitu kondisi kosong, steady-state dan rapid drawdown pada 

lereng hulu dan hilir dengan beban gempa dari setiap koefisien gempa 

termodifikasi. 

Hasil simulasi statis Bendungan Way - Apu untuk kondisi tanpa gempa 

ditunjukkan oleh Tabel 5.24. 

Tabel 5.24 Hasil Simulasi Analisis Statis Bendungan Tanpa Gempa 

No. Kondisi 
FK 

minimal 
y/h 

Faktor Keamanan Keterangan 

Hulu 

U/S 

Hilir 

D/S 
Hulu Hilir 

1 Selesai masa konstruksi, air 

kosong dan tanpa gempa 

1,3 - 2,578 2,247 Aman Aman 

2 Kondisi air steady state, muka 

air normal / Normal Water 

Level (NWL) +96,5 m tanpa 

gempa 

1,5 - 3,072 2,243 Aman Aman 

3 Kondisi muka air banjir / 

Flood Water Level (FWL) 

+98,8 m tanpa gempa 

1,3 - 3,210 2,243 Aman Aman 

4 Kondisi muka air minimum/ 

Low Water Level (LWL) 

+79,75 m tanpa gempa 

1,3 - 2,397 2,243 Aman Aman 

5 Kondisi surut cepat (Rapid 

Drawdown) dari muka air 

normal +96,5 m ke muka air 

minimum +79,75 m tanpa 

gempa 

1,3 - 2,429 2,148 Aman Aman 

6 Kondisi darurat surut cepat 

(Rapid Drawdown) dari muka 

air maksimum +98,8 m ke 

muka air minimum +79,75 m 

tanpa gempa 

1,3 - 2,382 1,955 Aman Aman 
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Hasil simulasi statis Bendungan Way - Apu untuk kondisi gempa OBE 

ditunjukkan oleh Tabel 5.25. 

 

Tabel 5.25 Hasil Simulasi Analisis Statis Bendungan Gempa OBE 

No. Kondisi 
FK 

minimal 
y/h 

Faktor Keamanan Keterangan 

Hulu 

U/S 

Hilir 

D/S 
Hulu Hilir 

1 Selesai masa konstruksi, air 

kosong dan dengan beban 

gempa 50% gempa OBE 

1,2 

0,25 1,614 1,534 Aman Aman 

0,50 1,625 1,621 Aman Aman 

0,75 1,717 1,527 Aman Aman 

1,00 1,749 1,578 Aman Aman 

2 Kondisi air steady state, muka 

air normal / Normal Water 

Level (NWL) +96,5 m dengan 

beban gempa 50% gempa OBE 

1,2 

0,25 1,683 1,534 Aman Aman 

0,50 1,637 1,621 Aman Aman 

0,75 1,460 1,527 Aman Aman 

1,00 1,543 1,578 Aman Aman 

3 Kondisi muka air banjir / 

Flood Water Level (FWL) 

+98,8 m dengan gempa OBE 

1,2 

0,25 1,780 1,534 Aman Aman 

0,50 1,711 1,621 Aman Aman 

0,75 1,494 1,527 Aman Aman 

1,00 1,579 1,578 Aman Aman 

4 Kondisi muka air minimum/ 

Low Water Level (LWL) 

+79,75 m dengan gempa OBE 

1,2 0,25 1,611 1,534 Aman Aman 

0,50 1,479 1,621 Aman Aman 
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No. Kondisi 
FK 

minimal 
y/h 

Faktor Keamanan Keterangan 

Hulu 

U/S 

Hilir 

D/S 
Hulu Hilir 

0,75 1,340 1,527 Aman Aman 

1,00 1,404 1,578 Aman Aman 

5 Kondisi surut cepat dari muka 

air normal +96,5 m ke muka 

air minimum +79,75 m, 

dengan gempa OBE 

1,1 0,25 1,152 1,314 Aman Aman 

0,50 1,249 1,389 Aman Aman 

0,75 1,296 1,424 Aman Aman 

1,00 1,352 1,465 Aman Aman 

6 Kondisi darurat surut cepat 

dari muka air normal +98,8 m 

ke muka air minimum +79,75 

m dengan gempa OBE 

1,1 0,25 1,187 1,269 Aman Aman 

0,50 1,288 1,340 Aman Aman 

0,75 1,337 1,374 Aman Aman 

1,00 1,395 1,413 Aman Aman 

 

Hasil simulasi statis Bendungan Way - Apu untuk kondisi gempa MDE 

ditunjukkan oleh Tabel 5.26. 

 

Tabel 5.26  Hasil Simulasi Analisis Statis Bendungan Gempa MDE 

No. Kondisi 
FK 

minimal 
y/h 

Faktor Keamanan Keterangan 

Hulu 

U/S 

Hilir 

D/S 
Hulu Hilir 

1 Selesai masa konstruksi, air 

kosong dan dengan beban 

1,0 0,25 0,847 0,813 Tidak 

Aman 

Tidak 

Aman 
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No. Kondisi 
FK 

minimal 
y/h 

Faktor Keamanan Keterangan 

Hulu 

U/S 

Hilir 

D/S 
Hulu Hilir 

gempa 50% gempa MDE 0,50 0,887 0,888 Tidak 

Aman 

Tidak 

Aman 

0,75 0,945 0,864 Tidak 

Aman 

Tidak 

Aman 

1,00 0,985 0,913 Tidak 

Aman 

Tidak 

Aman 

2 Kondisi air steady state, muka 

air normal / Normal Water 

Level (NWL) +96,5 m dengan 

beban gempa 50% gempa 

MDE 
1,0 

0,25 0,790 0,813 Tidak 

Aman 

Tidak 

Aman 

0,50 0,778 0,888 Tidak 

Aman 

Tidak 

Aman 

0,75 0,706 0,864 Tidak 

Aman 

Tidak 

Aman 

1,00 0,747 0,913 Tidak 

Aman 

Tidak 

Aman 

3 Kondisi surut cepat dari muka 

air normal +96,5 m ke muka 

air minimum +79,75 m dengan 

gempa MDE 

1,0 

0,25 0,597 0,707 Tidak 

Aman 

Tidak 

Aman 

0,50 0,660 0,777 Tidak 

Aman 

Tidak 

Aman 

0,75 0,695 0,817 Tidak 

Aman 

Tidak 

Aman 

1,00 0,736 0,859 Tidak 

Aman 

Tidak 

Aman 

 

Hasil perhitungan untuk analisis statik stabilitas lereng Bendungan Way - 

Apu memenuhi kriteria angka keamanan, baik pada sisi hilir maupun hulu dan 

dalam keadaan tanpa gempa maupun dengan beban gempa OBE atau gempa 

periode ulang 100 tahun.  

Sedangkan untuk beban gempa MDE tidak memenuhi persyaratan angka 

keamanan. Sesuai dengan Pd T-14-2004-A, pada kondisi yang tidak memenuhi 
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angka keamanan perlu dilakukan analisis dinamik untuk menghitung deformasi 

yang terjadi pada saat keadaan gempa. Dalam penelitian ini, perhitungan analisis 

dinamik dilakukan dengan QUAKE/W dan SLOPE/W. 

 

Gambar  5.60 Analisis SLOPE/W (Statis, masa konstruksi selesai, tanpa gempa) 

 

 

 

Gambar  5.61 Analisis SLOPE/W (Statis, NWL D/S Gempa y/h=0,25) 
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Gambar  5.62 Analisis SLOPE/W (Stability, rapid drowdown, tanpa gempa) 

 

 

 

Gambar  5.63 Analisis SLOPE/W (Slope stability, rapid drowdown, Gempa 

MDE y/h=0,25) 
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5.2.5 Analisis Dinamik Lereng Bendungan 

Dalam analisis dinamik kestabilan lereng bendungan dihitung dengan 

mempertimbangkan pengaruh perubahan waktu terhadap perubahan parameter. 

Sebagai contoh, koefisien gempa yang digunakan adalah koefisien gempa 

dinamik. Dalam penelitian ini koefisien gempa dinamik yang digunakan adalah 

data simulasi ground motion. Data ground motion ini diperoleh dengan 

menggunakan fungsi spectrum response dan time history pada aplikasi SAP2000. 

Simulasi ground motion dengan SAP2000 adalah sebagai berikut: 

1. Setelah membuat file baru pada aplikasi SAP2000.   

Klik Define→Function→Response Spectrum. Seperti tampak pada 

Gambar 5.64. 

 

Gambar  5.64 Menentukan Respon Spektrum Gempa  
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2. Membuat response spectrum berdasarkan koefisien gempa OBE dan MDE 

dari hasil simulasi PSHA. Function yang digunakan adalah IBC2012. Pada 

jendela Define Response Spectrum Function pilih IBC2010 dan Add New 

Function. 

 

Gambar  5.65 Mendefinisikan Respon Spektrum Gempa 

 

 

Gambar  5.66 Function Definition pada Respon Spektrum Gempa 
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Data Ss dan S1 diambil dari perhitungan PSHA dengan R-CRISIS dengan 

nilai tampak pada Tabel 5.27.  

 

Tabel 5.27  Nilai Parameter PSHA yang digunakan 

Parameter Gempa OBE Gempa MDE 

0,2 sec Spectral 

Acceleration, Ss 

0,4748 

 

1,5994 

1 sec Spectral 

Acceleration, S1 

0,1285 

 

0,4756 

 

 

3. Membuat time history sesuai dengan response spectrum yang telah dibuat.  

Klik Define → Functions → Time History → pilih type Matched to 

Response Spectrum seperti tampak pada Gambar 5.67.  

 

 

Gambar  5.67  Pembuatan Time History Gempa 
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Gambar  5.68 Pendefinisian Fungsi Time History  

 

Pada jendela Time History pilih response spectrum yang telah dibuat 

sebelumnya sebagai Target Response Spectrum. 

 

 

Gambar  5.69  Grafik Fungsi Time History  
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4. Data ini kemudian di-export ke format Microsoft Excel untuk kemudian 

digunakan sebagai input dalam analisis QUAKE/W. 

 

5.2.6 Perhitungan Displacement dengan QUAKE-W 

QUAKE/W adalah bagian dari aplikasi GeoStudio yang digunakan untuk 

menghitung analisis kestabilan akibat dari pengaruh gempa. Dalam penelitian ini 

QUAKE/W digunakan untuk menghitung displacement yang terjadi pada puncak 

bendungan pada saat menerima beban gempa baik gempa OBE maupun gempa 

MDE. 

Pada penelitian ini digunakan analisis QUAKE/W tipe initial static dan 

kemudian dilanjutkan dengan analisis tipe Linear Equivalent. Langkah - langkah 

analisis dinamik dengan QUAKE/W adalah sebagai berikut: 

1. Analisis QUAKE/W initial static untuk kondisi awal  

a. Membuat analisis QUAKE/W baru dengan tipe initial static dan initial 

PWP dari analisis SEEP/W sesuai dengan kondisi muka air yang 

dianalisis. 

 

Gambar  5.70  Pembuatan File Analisis QUAKE/W Baru 
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b. Input material properties untuk analisis QUAKE/W 

Material pada penelitian ini menggunakan tipe equivalent linear untuk 

dibuat fungsi masing-masing untuk G Reduction, Pore Water 

Pressure, Cyc. Num, Ka, KS, Damping ratio dan Gmax. 

 

Gambar  5.71   Input Properti Material pada QUAKE/W 

 

2. Analisis QUAKE/W dengan type dynamic quake untuk mendapatkan 

pengaruh gempa dinamik terhadap bendungan. Analisis dynamic quake ini 

menggunakan data time history dari SAP2000 sebagai Horizontal 

Earthquake Records. 

a. Membuat analisis QUAKE/W dengan type dynamic quake dan analisis 

Initial Static sebagai parent. 

Klik → Define Analyses → Add → QUAKE/W Analysis → Equivalent 

Linear Dynamic seperti tampak pada Gambar 5.72.  
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Gambar  5.72   Pembuatan Analisis QUAKE/W Tipe Dinamik 

 

Pada tab Time klik Define Horizontal Earthquake record untuk 

memasukkan data time history dari SAP2000 seperti tampak pada 

Gambar 5.73. 

 

Gambar  5.73   Pendefinisian Horizontal Earthquake 
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Gambar  5.74  Pendefinisian Horizontal Earthquake Record 

 

b. Menentukan boundary conditions pada bagian sumbu Y dengan Fixed 

X dan fixed X/Y untuk sumbu X.  

 

Gambar  5.75  Penentuan Boundary Condition 
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c. Setelah menjalankan simulasi, informasi mengenai displacement dapat 

dilihat dengan membuat plot grafik x-displacement vs time dan y-

displacement vs time. 

Pada jendela Result, klik Draw→Graph. 

 

 

Gambar  5.76  Penentuan Penggambaran Grafik  

 

Untuk membuat grafik x-displacement vs time digunakan tipe Mesh 

dan set location pada puncak bendungan serta tipe displacement dan 

X-Displacement. Hasil X-Displacement untuk kondisi steady-state 

muka air normal +96,5 m seperti tampak pada Gambar 5.77.  
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Gambar  5.77   Crest Displacement (x-displacement) 

 

Hasil Y-Displacement untuk kondisi steady-state muka air normal 

+96,5 m seperti tampak pada Gambar 5.78.  

 

 

Gambar  5.78  Crest Displacement  (y-displacement) 

 



136 

 

 
 

Hasil analisis dinamik lereng bendungan ditampilkan dalam nilai 

displacement pada puncak bendungan tampak seperti pada Tabel 5.28.  

 

Tabel 5.28  Hasil Analisis Dinamik Lereng Bendungan Way - Apu 

Kondisi Analisis X-displacement 

(m) 

Y-displacement 

(m) 

Keterangan 

Masa selesai 

konstruksi 

0,3008 0,1766 Aman 

Kondisi air 

normal 

0,3061 0,1770 Aman 

Kondisi surut 

cepat 

0,3008 0,1766 Aman 

 

 

Gambar  5.79  Crest Displacement Kondisi Air Normal 
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Gambar  5.80  Crest Displacement Kondisi Rapid Drowdown 

 

 

 

Gambar  5.81  Crest Displacement Kondisi Setelah Konstruksi 

 

5.2.7 Perhitungan Displacement dengan QUAKE-W 

Untuk memperoleh nilai faktor keamanan lereng bendungan dengan 

analisis dinamik, hasil dari QUAKE/W pada analisis sebelumnya dijadikan 

sebagai input dalam analisis SLOPE/W dengan tipe QUAKE/W Stress. Hasil 
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perhitungan faktor keamanan untuk beban gempa dinamik ditampilkan dalam 

Tabel 5.29 berikut ini.  

 

Tabel 5.29   Hasil Perhitungan Faktor Keamanan untuk Beban Gempa Dinamik 

No. Kondisi FK 

minimu

m 

FK Hulu FK Hilir Keteran

gan 

1 Setelah masa konstruksi 1,0 5,377 1,16 Aman 

2 Aliran steady-state 1,0 1,326 1,057 Aman 

3 Rapid drawdown 1,0 1,491 1,065 Aman 

 

Dari perhitungan displacement maupun slope stability dengan beban 

gempa dinamik, Bendungan Way - Apu memenuhi persyaratan angka faktor 

keamanan, baik untuk analisis displacement dengan QUAKE/W maupun analisis 

SLOPE/W dengan QUAKE/W Stress.  
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6.0   BAB VI   PENUTUP 

PENUTUP 

6.1 Kesimpulan 

Berdasarkan hasil penelitian dengan melakukan evaluasi faktor keamanan 

Bendungan Way - Apu dapat disimpulkan sebagai berikut: 

1. Berdasarkan simulasi analisis PSHA yang dilakukan, lokasi dibangunnya 

Bendungan Way - Apu memiliki potensi bahaya gempa yang 

dikategorikan dalam klasifikasi kelas risiko IV (ekstrem) dengan nilai 

tingkat risiko sebesar 34 point. 

2. Berdasarkan hasil simulasi analisis kestabilan lereng bendungan statik 

dengan kondisi tanpa gempa dan gempa OBE, bendungan Way - Apu 

memenuhi kriteria angka keamanan, baik pada sisi hilir maupun hulu. 

Namun, pada kondisi gempa MDE, analisis kestabilan lereng bendungan 

statik dengan kondisi gempa MDE, bendungan Way - Apu tidak 

memenuhi kriteria angka keamanan, baik pada sisi hilir maupun hulu. 

Sesuai dengan Pd T-14-2004-A, pada kondisi yang tidak memenuhi angka 

keamanan perlu dilakukan analisis dinamik untuk menghitung deformasi 

yang terjadi pada saat keadaan gempa. 

3. Berdasarkan hasil simulasi analisis kestabilan lereng bendungan dinamik, 

bendungan Way - Apu memenuhi kriteria angka keamanan, baik pada sisi 

hilir maupun hulu dalam kondisi setelah masa konstruksi, aliran steady-

state dan rapid drowdown. 

6.2 Saran 

Berdasarkan kesimpulan yang telah dipaparkan diatas maka dapat 

disarankan beberapa hal sebagai berikut. 

1. Perlu dilakukan analisis stabilitas dengan menggunakan data pembacaan 

piezometer di lapangan jika bendungan sudah selesai dibangun. 
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2. Pada penelitian ini perhitungan dilakukan dengan menggunakan software 

simulasi, alangkah baiknya apabila pada penelitian selanjutnya dilakukan 

perbandingan hasil antara perhitungan secara manual dan perhitungan 

menggunakan software simulasi. 
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Lampiran 1 Cuplikan Katalog Gempa 

 

Your search parameters are:          

      Mb 8397   Mb 10325 

catalog=ANSS     Me 14   Me 16 

start_time=1900/01/01,00:00:00   ML 4   ML 4 

end_time=2021/12/31,23:59:59   Ms 19   Ms 36 

minimum_latitude=-8.057896305   Mw 496   Mw 636 

maximum_latitude=0.951112705   Unk 0    11017 

minimum_longitude=122.3312896    8930     

maximum_longitude=131.3402986   lat lon     

minimum_magnitude=4    -3.55339 126.8358     

maximum_magnitude=9          

minimum_depth=0           

maximum_depth=300          

event_type=e           
 

 
Date 

Time 

Latitu

de 

Longitu

de 

Dept

h 

Magnit

ude 

Mag

Type 

NbStat

ions Mw 

round

Mw 

Distan

ce RMS 

Sou

rce EventID Year 

Mont

h 

Da

y 

Hou

r 

Mi

n Sec 

35:34.0 0.905 122.375 105 5.5 Mb 56 5.9505 5.95 700.06 0 NEI 1.98E+11 1976 4 9 11 35 34 

03:15.4 0.899 122.41 67 5.1 Mb 41 5.68954 5.69 696.84 0 NEI 1.98E+11 1975 4 14 13 3 15 

04:49.4 0.943 122.461 38 5.4 Mb 48 5.88184 5.88 696.35 0 NEI 1.98E+11 1975 3 15 16 4 49 

02:51.2 -7.99 131.271 90.9 4.2 Mb 9 5.23576 5.24 696.34 0.9 NEI 1.99E+11 1992 2 9 9 2 51 

21:33.8 -7.896 122.355 250 5.1 Mb 23 5.68954 5.69 692.62 0.97 NEI 2E+11 1996 9 3 9 21 34 

30:52.1 0.765 122.339 33 4.4 Mb 15 5.32064 5.32 692.04 0.89 NEI 2E+11 2003 11 26 17 30 52 

55:43.2 -7.999 122.477 35 4.6 Mb 16 5.41464 5.41 691.08 1.1 NEI 2.00707E+11 2007 7 5 0 55 43 

27:20.8 -7.862 131.324 33 4 Mb 6 5.16 5.16 690.6 0.57 NEI 1.99709E+11 1997 9 21 17 27 21 

34:52.9 -8.019 122.511 186.2 4.9 Mb 22 5.57274 5.57 690.04 0.6 NEI 1.99503E+11 1995 3 19 0 34 53 
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Date 

Time 

Latitu

de 

Longitu

de 

Dept

h 

Magnit

ude 

Mag

Type 

NbStat

ions Mw 

round

Mw 

Distan

ce RMS 

Sou

rce EventID Year 

Mont

h 

Da

y 

Hou

r 

Mi

n Sec 

04:13.6 0.841 122.46 59 5.4 Mb 66 5.88184 5.88 688.36 0 NEI 1.9781E+11 1978 10 12 7 4 14 

51:04.8 -8.048 122.591 250 4.7 Mb 15 5.46506 5.47 686.23 1.23 NEI 1.99701E+11 1997 1 13 6 51 5 

39:23.2 0.916 122.652 80.9 4.9 Mb 30 5.57274 5.57 679.55 0.9 NEI 2.00012E+11 2000 12 22 19 39 23 

33:22.7 -7.738 122.37 279 5.5 Mb 40 5.9505 5.95 679.32 0 NEI 1.97503E+11 1975 3 14 19 33 23 

36:54.8 0.599 122.35 74.9 5.9 Mw 159 5.9 5.9 678.51 1.1 NEI 2.00312E+11 2003 12 28 5 36 55 

07:14.3 0.838 122.6 51 5.5 Mb 109 5.9505 5.95 677.25 0 NEI 1.97603E+11 1976 3 6 11 7 14 

05:54.3 -7.868 122.524 150 4.7 Mb 26 5.46506 5.47 677.08 0.99 NEI 1.99512E+11 1995 12 6 1 5 54 

14:36.6 -7.922 122.604 281.1 5.2 Mb 14 5.75136 5.75 675.12 1.14 NEI 1.98603E+11 1986 3 23 14 14 37 

22:10.4 0.724 122.516 33 4.5 Mb 23 5.3665 5.37 674.79 0.93 NEI 1.99309E+11 1993 9 12 19 22 10 

53:56.3 -7.824 122.523 283 5 Mb 45 5.63 5.63 673.71 0 NEI 1.97707E+11 1977 7 21 8 53 56 

58:42.6 0.775 122.583 64 5.5 Mb 64 5.9505 5.95 673.55 0 NEI 1.97503E+11 1975 3 17 18 58 43 

11:48.3 0.566 122.389 73.3 4.6 Mb 10 5.41464 5.41 672.84 1.05 NEI 2.00604E+11 2006 4 30 6 11 48 

14:27.7 -7.949 130.988 36.6 4.2 Mb 19 5.23576 5.24 671.18 0.76 NEI 2.0101E+11 2010 10 24 3 14 28 

45:46.6 -7.734 122.468 262.2 4.9 Mb 98 5.57274 5.57 671.12 1.1 NEI 2.0101E+11 2010 10 30 17 45 47 

53:56.6 -8.046 122.796 221.2 5 Mb 36 5.63 5.63 670.64 1.16 NEI 1.98601E+11 1986 1 1 17 53 57 

19:10.7 -7.914 131.014 74 4.5 Mb 6 5.3665 5.37 670.35 1.28 NEI 1.99202E+11 1992 2 23 15 19 11 

18:35.6 0.769 122.621 70 6.1 Mb 194 6.41034 6.41 670.13 0 NEI 1.97505E+11 1975 5 27 10 18 36 

13:45.6 -8.014 122.768 194.8 4.4 Mb 10 5.32064 5.32 670.09 0.94 NEI 1.98412E+11 1984 12 15 1 13 46 

22:12.4 -7.621 122.377 33 4.8 Mb 15 5.51776 5.52 669.93 0.68 NEI 1.9881E+11 1988 10 19 10 22 12 

15:23.4 -7.927 122.683 250 4.2 Mb 9 5.23576 5.24 669.45 1.14 NEI 1.98706E+11 1987 6 22 1 15 23 

29:30.2 -8.017 122.788 206.3 4.4 Mb 33 5.32064 5.32 668.85 0.74 NEI 2.01108E+11 2011 8 21 14 29 30 

22:33.9 0.575 122.447 192 5.2 Mb 16 5.75136 5.75 668.82 0 NEI 1.97101E+11 1971 1 26 20 22 34 

08:41.1 -7.839 131.066 81.9 5.1 Mb 14 5.68954 5.69 668.41 1.7 NEI 1.99101E+11 1991 1 13 8 8 41 

48:49.9 0.468 122.354 119 4.5 Mb 8 5.3665 5.37 668.38 0 NEI 1.98101E+11 1981 1 12 1 48 50 

58:29.1 -7.826 122.597 264.8 6.1 Mw 339 6.1 6.1 668.06 0.99 NEI 2.00601E+11 2006 1 15 11 58 29 

29:26.7 0.483 122.389 153.3 5.1 Mb 46 5.68954 5.69 666.61 1.14 NEI 1.99006E+11 1990 6 24 5 29 27 

12:33.4 0.544 122.452 93.4 4.1 Mb 7 5.19674 5.2 666.06 0.98 NEI 2.00711E+11 2007 11 14 5 12 33 

46:09.2 -7.831 131.041 33 5.2 Mb 13 5.75136 5.75 665.83 0 NEI 1.97903E+11 1979 3 30 13 46 9 

18:05.4 0.874 122.795 175.4 4.6 Mb 12 5.41464 5.41 665.35 0.97 NEI 1.99211E+11 1992 11 29 16 18 5 

57:20.7 -7.891 122.699 182 5.1 Mb 48 5.68954 5.69 665.33 0.82 NEI 1.99903E+11 1999 3 18 23 57 21 

55:43.2 -7.999 122.477 35 4.6 Mb 16 5.41464 5.41 691.08 1.1 NEI 2.00707E+11 2007 7 5 0 55 43 

27:20.8 -7.862 131.324 33 4 Mb 6 5.16 5.16 690.6 0.57 NEI 1.99709E+11 1997 9 21 17 27 21 

34:52.9 -8.019 122.511 186.2 4.9 Mb 22 5.57274 5.57 690.04 0.6 NEI 1.99503E+11 1995 3 19 0 34 53 
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Lampiran 1  Peta Sumber Patahan dan Megathrust  

 

 
Gambar L1.1. Peta Megathrust Indonesia 
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Gambar L.1.2. Peta Patahan Aktif Indonesia 
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Gambar L.1.3. Peta Seismotektonik Indonesia 
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Lampiran 2 Peta PGA dan Spectral Acceleration 
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Lampiran 3 Hasil Analisis Statis dengan GeoStudio 
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Lampiran 4 Hasil Analisis Dinamik dengan GeoStudio 

 

 

Muka Air Normal Muka Air Kosong Rapid Draw Down

Node 742 (170.51479, 100) Node 742 (170.51479, 100) Node 742 (170.51479, 100)

Time (sec)

X-

Displaceme

nt (m)

Y-

Displaceme

nt (m)

Time (sec)

X-

Displaceme

nt (m)

Y-

Displaceme

nt (m)

Time (sec)

X-

Displaceme

nt (m)

Y-

Displaceme

nt (m)

0.200 0.000 0.000 0.200 0.000 0.000 0.200 0.000 0.000

0.400 0.000 0.000 0.400 0.000 0.000 0.400 0.000 0.000

0.600 0.000 0.000 0.600 0.000 0.000 0.600 0.000 0.000

0.800 0.000 0.001 0.800 0.000 0.001 0.800 0.000 0.001

1.000 0.000 0.004 1.000 0.000 0.004 1.000 0.000 0.004

1.200 -0.002 0.000 1.200 -0.002 0.000 1.200 -0.002 0.000

1.400 -0.006 -0.018 1.400 -0.007 -0.018 1.400 -0.007 -0.018

1.600 -0.035 -0.037 1.600 -0.037 -0.037 1.600 -0.037 -0.037

1.800 -0.120 -0.069 1.800 -0.123 -0.069 1.800 -0.123 -0.069

2.000 -0.176 -0.098 2.000 -0.178 -0.098 2.000 -0.178 -0.098

2.040 -0.186 -0.102 2.040 -0.188 -0.102 2.040 -0.188 -0.102

2.060 -0.192 -0.104 2.060 -0.194 -0.104 2.060 -0.194 -0.104

2.080 -0.199 -0.105 2.080 -0.200 -0.105 2.080 -0.200 -0.105

2.200 -0.253 -0.104 2.200 -0.253 -0.105 2.200 -0.253 -0.105

2.220 -0.264 -0.104 2.220 -0.264 -0.104 2.220 -0.264 -0.104

2.240 -0.276 -0.104 2.240 -0.276 -0.104 2.240 -0.276 -0.104

2.260 -0.289 -0.104 2.260 -0.288 -0.105 2.260 -0.288 -0.105

2.400 -0.351 -0.119 2.400 -0.348 -0.120 2.400 -0.348 -0.120

2.420 -0.351 -0.122 2.420 -0.348 -0.123 2.420 -0.348 -0.123

2.460 -0.344 -0.126 2.460 -0.340 -0.127 2.460 -0.340 -0.127

2.480 -0.338 -0.128 2.480 -0.334 -0.128 2.480 -0.334 -0.128

2.600 -0.281 -0.119 2.600 -0.276 -0.118 2.600 -0.276 -0.118

2.640 -0.265 -0.115 2.640 -0.260 -0.115 2.640 -0.260 -0.115

2.800 -0.280 -0.144 2.800 -0.279 -0.144 2.800 -0.279 -0.144

3.000 -0.288 -0.098 3.000 -0.284 -0.097 3.000 -0.284 -0.097

3.200 -0.208 -0.052 3.200 -0.204 -0.049 3.200 -0.204 -0.049

3.300 -0.174 -0.037 3.300 -0.169 -0.037 3.300 -0.169 -0.037

3.400 -0.132 -0.041 3.400 -0.127 -0.044 3.400 -0.127 -0.044

3.600 -0.006 -0.046 3.600 -0.008 -0.049 3.600 -0.008 -0.049

3.800 0.020 -0.010 3.800 0.011 -0.007 3.800 0.011 -0.007

4.000 0.035 0.035 4.000 0.028 0.039 4.000 0.028 0.039

4.200 -0.010 0.053 4.200 -0.013 0.048 4.200 -0.013 0.048

4.280 0.003 0.042 4.280 0.002 0.038 4.280 0.002 0.038

4.400 0.025 0.022 4.400 0.024 0.020 4.400 0.024 0.020

4.600 0.010 0.010 4.600 0.009 0.013 4.600 0.009 0.013

4.700 0.002 0.001 4.700 0.000 0.003 4.700 0.000 0.003

4.800 -0.001 0.009 4.800 -0.004 0.008 4.800 -0.004 0.008

4.880 -0.005 0.023 4.880 -0.005 0.021 4.880 -0.005 0.021

4.960 -0.021 0.031 4.960 -0.017 0.030 4.960 -0.017 0.030

5.000 -0.034 0.031 5.000 -0.028 0.031 5.000 -0.028 0.031

5.100 -0.070 0.027 5.100 -0.062 0.027 5.100 -0.062 0.027

5.200 -0.098 0.022 5.200 -0.093 0.022 5.200 -0.093 0.022

5.400 -0.042 0.022 5.400 -0.039 0.025 5.400 -0.039 0.025

5.600 -0.012 0.042 5.600 -0.009 0.041 5.600 -0.009 0.041

5.800 0.044 0.118 5.800 0.048 0.116 5.800 0.048 0.116

6.000 0.188 0.153 6.000 0.193 0.147 6.000 0.193 0.147

6.200 0.306 0.125 6.200 0.301 0.128 6.200 0.301 0.128

6.400 0.300 0.137 6.400 0.286 0.145 6.400 0.286 0.145

6.600 0.233 0.177 6.600 0.226 0.177 6.600 0.226 0.177

6.800 0.207 0.137 6.800 0.210 0.128 6.800 0.210 0.128

7.000 0.145 0.078 7.000 0.143 0.072 7.000 0.143 0.072

7.200 0.060 0.091 7.200 0.058 0.099 7.200 0.058 0.099

7.400 0.020 0.156 7.400 0.023 0.164 7.400 0.023 0.164

7.600 0.071 0.167 7.600 0.080 0.160 7.600 0.080 0.160

7.800 0.136 0.120 7.800 0.149 0.115 7.800 0.149 0.115

8.000 0.191 0.102 8.000 0.192 0.113 8.000 0.192 0.113

8.200 0.217 0.125 8.200 0.212 0.128 8.200 0.212 0.128

8.400 0.196 0.104 8.400 0.192 0.091 8.400 0.192 0.091

8.600 0.103 0.081 8.600 0.094 0.078 8.600 0.094 0.078

8.800 -0.018 0.086 8.800 -0.030 0.094 8.800 -0.030 0.094

9.000 -0.063 0.088 9.000 -0.065 0.092 9.000 -0.065 0.092

9.100 -0.073 0.084 9.100 -0.072 0.080 9.100 -0.072 0.080

9.200 -0.089 0.065 9.200 -0.083 0.057 9.200 -0.083 0.057

9.400 -0.066 0.060 9.400 -0.051 0.054 9.400 -0.051 0.054

9.600 0.014 0.059 9.600 0.021 0.068 9.600 0.021 0.068

9.800 0.064 0.082 9.800 0.065 0.091 9.800 0.065 0.091

10.000 0.090 0.089 10.000 0.097 0.087 10.000 0.097 0.087
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